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1 Introduction

1.1 About this document

1.1.1 Description of the contents
This manual describes the Hilscher EU5C­SWD­PROFINET gateway. Here
you will find information on how to install, configure and operate the
gateway.

This manual is intended for automation technicians and engineers. Detailed
knowledge of PROFINET IO is presumed. In addition, readers should also
be familiar with the handling of the SmartWire­DT system.

Important:
Ø To avoid personal injuries or damage of electrical devices,
please read this manual carefully before installing and using the
EU5C­SWD­PROFINET gateway.

Ø Please first read the chapter Safety [} page 16].

1.1.2 List of revisions
Index Date Revisions
1 2012­06­01 Created
2 2012­06­25 Scope of Delivery section substituted by Software Package section
3 2012­07­16 Installation program for USB driver added

Section Notes on Installing the USB driver added
4 2013­03­28 Section Versions of Devices, Firmware, Software Tools, Drivers and

Device Description File updated
Section Device Type Label added
Section Compatibility of SmartWire­DT Devices and Gateway
updated
Section Updating Firmware and Device Description File revised

5 2013­10­01 References to directory of product DVD updated
Device picture updated
Section Compatibility of SmartWire­DT Devices and Gateway
removed from document

6 2014­11­05 Chapter Firmware Recovery via HTTP added
Section Software Package updated
Path for downloading GSDML file in section GSDML Device
Description File updated
Obsolete cross reference to removed section Compatibility of
SmartWire­DT Devices and Gateway deleted
Description of POW LED in section Descriptions of the LEDs
updated.
Contacts section updated
Safety symbols revised according to ANSI.

7 2015­06­17 Design of safety messages updated.
Section Alarms and diagnosis controlled by the gateway [} page 92
] updated.

Table 1: List of revisions
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1.1.3 Conventions in this document
Notes, operation instructions and results of operation steps are marked as
follows:

Notes

Note:
<important note>

Note:
<simple note>

<note, where to find further information>

Operation instructions

1. <operational step>
Ø <instruction>

2. <operational step>
Ø <instruction>

Results

 <intermediate result>

 <final result>

For a description of the labeling of Safety Messages, see section Labeling
of safety messages [} page 20].
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1.2 Versions of devices, firmware, software, drivers and device
description file

The hardware revisions and software versions functionally belong together.
This means that certain revisions of the hardware of the gateway need
certain versions of firmware, software and drivers, in order to function
properly. 
This section lists the hardware revisions and the versions of the firmware,
the configuration software, the drivers and the device description file which
functionally belong together and to which all instructions in this manual
refer.

Device and firmware

This manual refers to the following hardware revision and firmware version
of the EU5C­SWD­PROFINET gateway:

Device type name Protocol Part number Hardware
revision

Firmware Firmware
version

EU5C­SWD­PROFINET PROFINET IO Device 9233.920 3 E030D0U0.nxf 1.4.x.x
Table 2: Reference to hardware and firmware

Important:
Versions of firmware and device description files functionally belong
together. This means that the firmware version specified here is not
compatible with a device description file older than the one specified
below, and vice versa.
If your gateway is running with a firmware version older than 1.4.x.x,
it is strongly recommended to update the firmware and to use the
version of the device description file specified below.
Since version 1.4.x.x, the version of the firmware which has been
loaded in the gateway before delivery can be inferred from the
device type label attached to the gateway.

GSDML device description file

This manual refers to the following device description file:
Device description file File name
GSDML for EU5C­SWD­PROFINET gateway GSDML­V2.2­Hilscher­EU5C­SWD­XXXXXXXX.xml

Table 3: Reference to device description file

Software tools

This manual refers to the following software versions:
Software Manufacturer Version
Ethernet Device Configuration Tool Hilscher 1.501
STEP 7 Siemens 5.4 SP5 / 5.5
SWD­Assist Eaton 1.90
Table 4: Reference to software tools
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Drivers

This manual refers to the following driver versions:
Driver File name Version
USB Driver for Windows usbser.sys Depending on Windows

version
Table 5: Reference to drivers

1.3 Software package

1.3.1 Overview
Hilscher offers the optional software package EU5C­SWD­SW (part
number 3233.920) for SmartWire­DT Gateways. The package features the
SmartWire­DT Gateway Solutions product DVD and a Mini­USB cable.
The SmartWire­DT Gateway Solutions product DVD contains the GSDML
Device description file necessary for configuring the EU5C­SWD­
PROFINET gateway within the PROFINET network. If you do not need the
whole package with the USB cable, you can download the contents of the
product DVD separately and free of charge as ZIP file from our website
www.hilscher.com under Products > Partner Products > SmartWire­DT >
EU5C­SWD­PROFINET > Downloads > Software.

1.3.2 Contents of the product DVD
The SmartWire­DT Gateway Solutions product DVD contains software for
all types of SmartWire­DT gateways. Depending on the gateway type you
are using, you will need only certain features of the DVD.

The product DVD includes:
· Device description files
· Firmware
· Eaton SWD­Assist software
· Wizard for installing the software available on the DVD and for
downloading the latest version of the SWD­Assist software from the
internet

· Installation program for USB driver (USB driver is needed for
connecting the gateway to a PC in order to use the Eaton SWD­Assist
software)

· Installation program for the Hilscher Ethernet Device Configuration Tool
· Documentation in PDF format
· Installation program for Adobe Reader
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The product DVD has the following directories:
Directory Contents
Documentation PDF manuals in German and English and installation program for Adobe Reader
EDS GSDML device description files and bitmaps, to be imported directly into the PROFINET

IO engineering tool.
Firmware Loadable gateway firmware
fscommand Files for start screen of product DVD
Setups & Drivers SWD­Assist software

Folder: SWD­Assist

Wizard for installing the software available on the DVD and for downloading the latest
version of the SWD­Assist software from the internet
Folder: Setup

Installation program for Ethernet Device Configuration Tool
Folder: EnDeviceCfg

Installation program (setup.exe) and .INF­ and .CAT­ files for Windows USB driver.
Folder: USB Driver

Table 6: Directory of the product DVD

Note:
You can use the wizard on the product DVD to download updates of
the Eaton SWD­Assist software, or you can download SWD­Assist
directly from the www.moeller.net website under Support >
Download Center. Direct link: 
http://downloadcenter.moeller.net/en/software.a487d8b7‐
da91‐486f‐b3ba‐a7ca2035db99
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1.3.3 How to use the product DVD
Insert the SmartWire­DT Gateway Solutions product DVD into the DVD
drive of your configuration PC. 
If the auto start function of your DVD drive is enabled, the start screen of
the DVD automatically opens. You can also start the DVD by double­
clicking the SmartWire.exe file in the root directory of the DVD.

In the menu of the start screen of the DVD, click Install Planning and
Configuration Tools to open a wizard for installing the software programs
stored on the DVD. The wizard also helps you to download the latest
version of the Eaton planning software SWD­Assist from the internet. It
automatically checks for already installed software components (which e. g.
might have been installed for an earlier project), and lists the missing
components accordingly. The following options might be offered:
· USB Driver: installs USB driver for Windows on your PC.
· Download Center SWD­Assist (manual update): connects your
browser to a web page where you can download the latest version of
the SWD­Assist software.

· SWD Planning Software SWD­Assist Vx.xx: installs the SWD­Assist
software version provided on the DVD.

· Ethernet Device Scanner/Configuration Tool: installs the Hilscher
Ethernet Device Configuration Tool.

· GSDML, EDS, ESI files (HTML page): opens a web page containing
links to the device description files.

In the main menu of the start screen of the DVD, you can furthermore open
a web page which provides an overview of all available documents (menu
Documentation). You can also directly open the folder containing the
device description files (menu Open Electronic Device Description Files
Directory).
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1.3.4 Notes on installing the USB Driver
If you intend to use the SWD­Assist software, you should first install the
USB driver on your PC before you connect the gateway via USB.

To install the USB driver from the DVD, choose Install Planning and
Configuration Tools in the DVD menu to open the installation wizard, and
then select the USB driver option. As an alternative, you can use the
Windows Explorer to open the Setups & Drivers\USB Driver folder on
the DVD, and then double­click the setup.exe file. Just follow the
instructions of the installation routine afterwards.

Note:
Under Windows XP, the installation process is not yet finished by
the setup. The installation process has to be completed in the
Found new Hardware Wizard, which automatically opens when
you connect the gateway to a PC via USB cable for the first time
(see below).

Windows XP

When you connect the gateway via USB for the first time to a PC running
under Windows XP, the Found New Hardware Wizard opens:
Ø Answer the question Can Windows connect to Windows Update…?,
with No, not this time. Then click Next button.

Ø If you have already carried out the setup of the USB driver (as
recommended), you can ignore the wizard’s request to insert a CD or
floppy disk. Answer the What do you want the wizard to do? question
by selecting the Install the software automatically option, then click
Next button.

Ø After the installation is complete, click Finish button.

Windows 7 and 8

The USB connection is instantly operative under Windows 7 and 8 if you
have carried out the setup of the USB driver before first connecting the
USB cable (as recommended).

Uninstall USB Driver

If you want to remove the USB driver from a PC running under Windows
XP, choose Start menu > Control Panel > Add or Remove Programs,
then select: 
Windows Driver Package – Hilscher GmbH (hilusbser) Ports entry.
Click Change/Remove button to uninstall the driver.

Under Windows 7 and 8, choose Start menu > Control Panel > Uninstall
a program, then select: 
Windows Driver Package – Hilscher GmbH (hilusbser) Ports entry.
Click Uninstall/Change button to uninstall the driver.
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1.4 Documentation overview
Besides this user manual at hand (path on product DVD: Documentation
\english\2.Hardware\EU5C­SWD­PROFINET UM xx EN.pdf) ), the
following documents are also relevant for the user of the EU5C­SWD­
PROFINET gateway:

Title Contents Publisher Document ID Path on product DVD
SmartWire­DT
Units

Information on
engineering, installation
and programming of the
individual SmartWire­DT
slaves.

Eaton MN05006001Z­EN Documentation\english\
3.SmartWire­DT\SmartWire­DT –
Units\
MN05006001Z_EN.pdf

SmartWire­DT
The System

Information on function,
installation,
commissioning and
diagnostics of the
SmartWire­DT system.

Eaton MN05006002Z­EN Documentation\english\
3.SmartWire­DT\SmartWire­DT ­
The System\
MN05006002Z_EN.pdf

Ethernet Device
Configuration

Operating Instruction
Manual of Hilscher
Ethernet Device
Configuration Tool.

Hilscher DOC050402OI05EN Documentation\english\
1.Software\Ethernet Device Setup
Utility\
Ethernet Device Configuration OI xx
EN.pdf

PROFINET
Installation
Guideline for
Cabling and
Assembly

Information on
PROFINET cabling.

PROFIBUS
Nutzer­
organisation
e.V.

Order No: 8.072
Identification:
TC2­08­0002

Documentation\english\
5.Installation Instructions
\PROFINET_Guideline_Assembly_8
072_V10_Jan09.pdf

SWD­Assist
Online help

Online help for SWD­
Assist planning software

Eaton ­ Included in SWD­Assist software

Table 7: Documentation overview
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1.5 Legal notes

1.5.1 Copyright
© Hilscher 2012 − 2015, Hilscher Gesellschaft für Systemautomation mbH

All rights reserved.

The images, photographs and texts in the accompanying material (user
manual, accompanying texts, documentation, etc.) are protected by
German and international copyright law as well as international trade and
protection provisions. You are not authorized to duplicate these in whole or
in part using technical or mechanical methods (printing, photocopying or
other methods), to manipulate or transfer using electronic systems without
prior written consent. You are not permitted to make changes to copyright
notices, markings, trademarks or ownership declarations. The included
diagrams do not take the patent situation into account. The company
names and product descriptions included in this document may be
trademarks or brands of the respective owners and may be trademarked or
patented. Any form of further use requires the explicit consent of the
respective rights owner.

1.5.2 Important notes
The user manual, accompanying texts and the documentation were created
for the use of the products by qualified experts, however, errors cannot be
ruled out. For this reason, no guarantee can be made and neither juristic
responsibility for erroneous information nor any liability can be assumed.
Descriptions, accompanying texts and documentation included in the user
manual do not present a guarantee nor any information about proper use
as stipulated in the contract or a warranted feature. It cannot be ruled out
that the user manual, the accompanying texts and the documentation do
not correspond exactly to the described features, standards or other data of
the delivered product. No warranty or guarantee regarding the correctness
or accuracy of the information is assumed.

We reserve the right to change our products and their specification as well
as related user manuals, accompanying texts and documentation at all
times and without advance notice, without obligation to report the change.
Changes will be included in future manuals and do not constitute any
obligations. There is no entitlement to revisions of delivered documents.
The manual delivered with the product applies.

Hilscher Gesellschaft für Systemautomation mbH is not liable under any
circumstances for direct, indirect, incidental or follow­on damage or loss of
earnings resulting from the use of the information contained in this
publication.
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1.5.3 Exclusion of liability
The software was produced and tested with utmost care by Hilscher
Gesellschaft für Systemautomation mbH and is made available as is. No
warranty can be assumed for the performance and flawlessness of the
software for all usage conditions and cases and for the results produced
when utilized by the user. Liability for any damages that may result from the
use of the hardware or software or related documents, is limited to cases of
intent or grossly negligent violation of significant contractual obligations.
Indemnity claims for the violation of significant contractual obligations are
limited to damages that are foreseeable and typical for this type of contract.

It is strictly prohibited to use the software in the following areas:
· for military purposes or in weapon systems;
· for the design, construction, maintenance or operation of nuclear
facilities;

· in air traffic control systems, air traffic or air traffic communication
systems;

· in life support systems;
· in systems in which failures in the software could lead to personal injury
or injuries leading to death.

We inform you that the software was not developed for use in dangerous
environments requiring fail­proof control mechanisms. Use of the software
in such an environment occurs at your own risk. No liability is assumed for
damages or losses due to unauthorized use.

1.5.4 Warranty
Although the hardware and software was developed with utmost care and
tested intensively, Hilscher Gesellschaft für Systemautomation mbH does
not guarantee its suitability for any purpose not confirmed in writing. It
cannot be guaranteed that the hardware and software will meet your
requirements, that the use of the software operates without interruption and
that the software is free of errors. No guarantee is made regarding
infringements, violations of patents, rights of ownership or the freedom from
interference by third parties. No additional guarantees or assurances are
made regarding marketability, freedom of defect of title, integration or
usability for certain purposes unless they are required in accordance with
the law and cannot be limited. Warranty claims are limited to the right to
claim rectification.
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1.5.5 Export regulations
The delivered product (including the technical data) is subject to export or
import laws as well as the associated regulations of different counters, in
particular those of Germany and the USA. The software may not be
exported to countries where this is prohibited by the United States Export
Administration Act and its additional provisions. You are obligated to
comply with the regulations at your personal responsibility. We wish to
inform you that you may require permission from state authorities to export,
re­export or import the product.

1.5.6 Registered trademarks
Adobe Reader®  is a registered trademark of the Adobe Systems
Incorporated.

PROFINET® is a registered trademark of PROFIBUS & PROFINET
International (PI), Karlsruhe.

SmartWire­DT® is a registered trademark of Eaton Corporation.

S7®, S7­300® and S7­400® are registered trademarks of Siemens AG,
Berlin and Munich.

STEP®7 is a registered trademark of Siemens AG, Berlin and Munich.

Windows® XP, Windows® Vista, Windows® 7 and Windows® 8 are
registered trademarks of Microsoft Corporation.

All other mentioned trademarks are property of their respective legal
owners.
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2 Safety

2.1 General note
The user manual, all accompanying texts and the documentation are
written for the use of the products by educated personnel. When using the
products, all safety instructions, property damage messages and all valid
legal regulations have to be observed. Technical knowledge is presumed.
The user has to assure that all legal regulations are obeyed.

2.2 Intended use
The purpose of the EU5C­SWD­PROFINET gateway described in this user
manual is to create a connection between SmartWire­DT slaves and an
overriding PROFINET IO controller (master device).

2.3 Personnel qualification
The gateway must be installed, configured and removed by qualified
personnel only. Job­specific technical skills for people professionally
working with electricity must be present concerning the following issues:
· Safety and health at work
· Mounting and connecting of electrical equipment
· Measurement and analysis of electrical functions and systems
· Evaluation of the safety of electrical systems and equipment
· Installing and configuring IT systems

2.4 References safety
[S1] ANSI Z535.6­2006 American National Standard for Product Safety Information in

Product Manuals, Instructions, and Other Collateral Materials
[S2] IEC 60950­1, Information technology equipment ­ Safety ­ 

Part 1: General requirements,
(IEC 60950­1:2005, modified); German Edition EN 60950­1:2006

[S3] EN 61340­5­1 and EN 61340­5­2 as well as IEC 61340­5­1 and IEC 61340­5­2
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2.5 Safety instructions to avoid personal injury
To ensure your own personal safety and to avoid personal injury, you must
read, understand and follow the following safety instructions in this manual
and all warning messages before you install and operate the gateway.

2.5.1 Electrical shock hazard
Take care of the following safety measures before installing or uninstalling
the gateway:
· First disconnect the power plug of the device.
· Make sure that the device is disconnected from the power supply.
· Cover or enclose neighboring units that are live.

Devices that are designed for mounting in housings or control cabinets
must only be operated and controlled after they have been installed with
the housing closed. Desktop or portable units must only be operated and
controlled in enclosed housings.

2.5.2 Danger of unintended starting up of machines
· Install automation devices and related operating elements in a way that
they are well protected against unintentional operation.

· Emergency stop devices complying with IEC/EN 60204­1 must be
effective in all operating modes of the automation devices. Unlatching
the emergency­stop devices must not cause restart.

· You must take safety precautions (emergency switching off) in the
external circuitry of the gateway and any power modules type EU5C­
SWD­PF1­1 or EU5C­SWDPF2­1 that are used. To do so, plan to
switch off the power supply to the contactor coils AUX.

· Measures should be taken to ensure the proper restart of programs
interrupted after a voltage dip or failure. This should not cause
dangerous operating states even for a short time. If necessary,
emergency stop devices should be implemented.

· Wherever faults in the automation system may cause damage to
persons or property, external measures must be implemented to ensure
a safe operating state in the event of a fault or malfunction (for example,
by means of separate limit switches, mechanical interlocks etc.).
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2.6 Safety instructions to avoid property damage
To avoid damage to your gateway or your communication system, you
must read, understand and follow the following safety instructions and all
safety instructions and warnings in this manual concerning property
damage, before you install and operate the gateway.

2.6.1 General safety instructions concerning supply voltage
· In safety­relevant applications the power supply providing power to the
SmartWire­DT system must feature a PELV power feed module
(protective extra low voltage).

· Switch off the power supply if you are reconnecting slaves in the
SmartWire­DT system or reconnecting the ribbon cable connection.
Otherwise the SmartWire­DT slaves can be destroyed!

· The gateway has protection against polarity reversal for the 24­V­DC­
POW supply. However, if the gateway is connected via the serial
interface to an earthed device (for example to a PC), the gateway can
be destroyed, if the polarity of the power supply is reversed!

· The functional earth (FE) must be connected to the protective earth
(PE) or to the potential equalization. The system installer is responsible
for implementing this connection.

· Connecting cables and signal lines should be installed so that inductive
or capacitive interference does not impair the automation functions.

· Suitable safety hardware and software measures should be
implemented for the I/O interface so that a line or wire breakage on the
signal side does not result in undefined states in the automation
devices.

2.6.2 Device destruction by exceeding allowed supply voltage
The gateway must only be operated with the specified supply voltage.
· Make sure that the limits of the allowed range for the supply voltage are
not exceeded. A supply voltage above the upper limit can cause severe
damage of the gateway!

· A supply voltage below the lower limit can cause malfunction of the
gateway!

· Ensure a reliable electrical isolation of the low voltage for the 24 volt
supply. Only use power supply units complying with IEC 60364­4­41
(VDE 0100 Part 410) or HD 384.4.41 S2.

The allowed range for the supply voltage is indicated in section Technical
data EU5C­SWD­PROFINET gateway [} page 105].
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2.6.3 Electrostatic sensitive device
The gateway is sensitive to electrostatic discharge, which can cause
internal damage and affect its normal operation. Therefore adhere to the
necessary safety precautions for components that are vulnerable to
electrostatic discharge when you install or remove the gateway. Follow the
guidelines listed hereafter when you handle the gateway:
· Touch a grounded object to discharge potential static before you handle
the gateway.

· Wear an approved grounding wrist strap.
· If possible, use a static­safe workstation.
· When not in use, store the device in appropriate static­safe packaging.
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2.7 Labeling of safety messages
In this document the safety instructions and property damage messages
are designed according both to the internationally used safety conventions
as well as to the ANSI Z535 standard.
· The Section Safety Messages at the beginning of a chapter are
pinpointed particularly and highlighted by a signal word according to the
degree of endangerment. The kind of danger is specified exactly by the
safety message text and optionally by a specific safety sign.

· The Integrated Safety Messages embedded in operating instructions
are highlighted by a signal word according to the degree of
endangerment. In the safety message, the nature of the hazard is
indicated.

Signal words and safety signs in safety messages on personal injury

Signal word Meaning
Indicates a direct hazard with high risk, which will have as consequence
death or grievous bodily harm if it is not avoided.
Indicates a possible hazard with medium risk, which will have as
consequence death or (grievous) bodily harm if it is not avoided.
Indicates a minor hazard with medium risk, which could have as
consequence personal injury if it is not avoided.

Table 8: Signal words in safety messages on personal injury

Safety sign Sort of warning or principle
Warning of lethal electrical shock

Principle: Disconnect the power plug

Table 9: Safety signs in messages on personal injury

Signal words and safety signs in safety messages on property
damage

Signal word Meaning
Indicates a property damage message

Table 10: Signal words in safety messages on property damage

Safety sign Sort of warning or principle
Warning of property damage by electrostatic discharge

Table 11: Safety signs in safety messages on property damage
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3 Description of the EU5C­SWD­PROFINET gateway

3.1 Function
The EU5C­SWD­PROFINET Gateway integrates a SmartWire­DT network
into a PROFINET network. The Gateway creates a data connection
between the participants (the slaves) of the subordinate SmartWire­DT
network and the controller (the master or PLC) of the superordinate
PROFINET IO network.

The gateway acts as master in the SmartWire­DT network, and as modular
IO Device (slave) in the PROFINET network. It thereby presents each
connected SmartWire­DT participant as individual module to the
PROFINET IO Controller.

The cyclic process data is exchanged transparently between both
networks. 1000 Bytes of process input/output data can in sum be
exchanged with up to 99 SmartWire­DT participants (slaves).

Figure 1: Data flow EU5C­SWD­PROFINET gateway
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3.2 Configuration
The EU5C­SWD­PROFINET Gateway is easily commissioned by an
automated configuration function: On pushing the configuration button on
the front of the gateway, the gateway scans the current SmartWire­DT
network configuration, the so­called actual configuration. It then stores the
actual configuration as target configuration zero voltage­safe in the device,
thus making the target configuration available for a comparison of actual
and targeted SmartWire­DT configuration, which takes place each time the
gateway is being switched on.

When the gateway is switched on after a target configuration has already
been stored, the gateway automatically rescans the connected actual
configuration and checks it against the target configuration. It then gets
ready for PROFINET IO and waits for the PROFINET configuration. The
gateway checks the project configuration, which it receives from the
PROFINET IO controller, against the target configuration. Discrepancies
between target and actual, or between target and project configurations are
reported by the gateway via PROFINET­Diagnosis.

The gateway is commissioned in PROFINET by using a PROFINET IO
controller engineering tool and a GSDML device description file, which is to
be imported into engineering tool. The GSDML file of the gateway is stored
in the EDS\EU5C­SWD­PROFINET\Vx.x.x.x. directory of the
SmartWire­DT Gateway Solutions DVD. The file contains all configuration
data and all possible SmartWire­DT slaves as I/O modules.

Note:
The GSDML device description file contains only I/O information for
SmartWire­DT slaves which were listed as sales products at the
time of creation of the file.

Eaton SWD­Assist planning software

In principle, you can build­up and configure a SmartWire­DT network
without any software tools. However, it is recommended to use the SWD­
Assist software to plan, dimension and document the SmartWire­DT
network. In SWD­Assist, a project specific GSDML file can be created and
exported. Using this file gives you the benefit of finding the I/O modules of
the SmartWire­DT slaves already preconfigured in your PROFINET
controller engineering tool.

For further information, please refer to the SWD­Assist online help.
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Note:
You will find the Eaton SWD­Assist software on the product DVD,
which is included in the EU5C­SWD­SW software package (order
number 3233.920) available from Hilscher. You can use the wizard
on the product DVD to download updates of the Eaton SWD­Assist
software, or you can download SWD­Assist directly from the
www.moeller.net website under Support> Download Center.
Direct link: http://downloadcenter.moeller.net/de/
software.a487d8b7‐da91‐486f‐b3ba‐a7ca2035db99

3.3 Interfaces
The gateway features a SmartWire­DT interface (plug, 8­pole), a 2­port
switch Ethernet interface (RJ45) for connecting PROFINET, and a Mini­
USB interface. Via the Mini­USB interface, the gateway can communicate
with the SWD­Assist software.

3.4 Diagnosis
The gateway can be diagnosed by connecting the SWD­Assist software to
the Mini­USB interface. For further information, please refer to the SWD­
Assist online help.

The PROFINET IO protocol also provides diagnostic functions. For further
information, see section Alarms and diagnosis controlled by the gateway [}
 page 92].

3.5 Updating firmware and device description file
The EU5C­SWD­PROFINET gateway is shipped with its most recent
firmware already loaded.

Note:
If your gateway is running with a firmware version older than 1.4.x.x,
it is strongly recommended to update the firmware and to use the
version of the device description file specified in section Bezug auf
Geräte, Firmware, Software, Treiber und Gerätebeschreibungsdatei
[} page 7]. Since version 1.4.x.x, the version of the firmware which
has been loaded in the gateway before delivery can be inferred
from the device type label attached to the gateway.

You can update the firmware from your configuration PC by using an
ordinary web browser. A web server embedded in the gateway, which can
be accessed via its Ethernet interface, provides a special web page for
updating the firmware. For more details on this, please refer to chapter
Updating firmware [} page 95]. In case of a missing or defective firmware,
a firmware “recovery” process is possible via HTTP. Please refer to chapter
Firmware recovery via HTTP [} page 100].
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Device description files (GSDML) for the gateway are included on the
product DVD in the EDS\EU5C­SWD­PROFINET\Vx.x.x.x folder. As an
alternative, you can download the latest versions of the GSDML files from
our website www.hilscher.com under Products> Partner Products >
SmartWire­DT > EU5C­SWD­PROFINET > Downloads.

Important:
Versions of firmware and device description files functionally belong
together. This means that after having updated the firmware to
version 1.4.x.x, you also need to replace the old version of the
GSDML file (GSDML­V2.25­Hilscher­EU5C­SWD­201206XX.xml)
with the new version of the GSDML file (GSDML­V2.2­Hilscher­
EU5C­SWD­XXXXXXXX.xml). This applies also the other way
round: If you intend to use the new GSDML file GSDML­V2.2­
Hilscher­EU5C­SWD­XXXXXXXX.xml, you need to update the old
version of the firmware (1.0.x.x) to the new version of the firmware
(1.4.x.x).
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4 Requirements for operation
The following prerequisites must be fulfilled to operate the gateway:

4.1 Network system
· SmartWire­DT network with maximum number of up to 99 participants/
stations/slaves and maximum extension of up to 600 meters.

· PROFINET IO network with PROFINET IO Controller (master)
respectively PLC. Maximum cable length for one segment (cable
between two switches) is 100 meters.

4.2 Power supply

Danger of unsafe operation of the system
In safety­relevant applications the power supply providing power for the
SmartWire­DT system must feature a PELV power feed module (protective
extra low voltage).

Danger of unsafe operation of the system
You must take safety precautions (emergency switching off) in the external
circuitry of the gateway and any power modules type EU5C­SWD­PF1­1 or
EU5C­SWDPF2­1 that are used. To do so, plan to switch off the power
supply to the contactor coils AUX.

Device destruction
Ensure a reliable electrical isolation of the low voltage for the 24 volt
supply. Only use power supply units complying with IEC 60364­4­41 (VDE
0100 Part 410) or HD 384.4.41 S2.

Important:
Please take into consideration the total power consumption of your
SmartWire­DT network and, if necessary, plan for an additional
feeder module EU5C­SWD­PF2. 
You can find information on the power consumption in the operating
manuals of the SmartWire­DT devices.
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4.2.1 POW power connection
A Power supply of 24 V DC for the coupling unit and for the Smart­Wire­DT
slave electronics is needed at the connection POW.

On the SmartWire­DT gateway, connect the POW and AUX supply
voltages via separate miniature circuit­breakers or fuses:

Miniature circuit­breaker 24 V DC for POW
· Cable protection in accordance with DIN VDE 0641 Part 11, IEC/EN
60898:
Miniature circuit­breaker 24 V DC rated operational current 3 A; trip
types C or Fuse 3 A, utilization class gL/gG

· Cable protection for cable AWG 24 in accordance with UL 508 und
CSA­22.2 No. 14: 
Miniature circuit­breaker 24 V DC rated operational current 3 A; Tripping
characteristics C or Fuse 3 A

4.2.2 AUX power connection
If any switching devices are also to be connected, for example via the DIL­
SWD­32­001/002 SmartWire­DT slaves, a 24 V DC supply will also be
required at the AUX power connection. This provides the supply for
activating the contactor coils. This supply must be protected by an
automatic circuit­breaker (3A gG/gl or 3 A miniature circuit­breaker with a Z
characteristic). 
If switching devices with an activation power greater than 3 A are
connected, an additional feeder module EU5C­SWD­PF1 or EU5C­SWD­
PF2 must be used.

On the SmartWire­DT gateway, connect the POW and AUX supply
voltages via separate miniature circuit­breakers or fuses:

Miniature circuit­breaker 24 V DC for AUX
· Cable protection in accordance with DIN VDE 0641 Part 11, IEC/EN
60898:
Miniature circuit­breaker 24 V DC rated operational current 3 A; trip type
Z or Fuse 3 A, utilization class gL/gG

· Cable protection for cable AWG 24 in accordance with UL 508 und
CSA­22.2 No. 14: 
Miniature circuit­breaker 24 V DC rated operational current 2 A; Tripping
characteristics Z or Fuse 2 A
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5 Device picture, connectors and LEDs

5.1 Device picture

(1) 24 V power supply POW

(2) PROFINET IO interface (RJ45)

(3) LEDs communication status PROFINET IO

(4) Mini­USB interface

(5) Configuration button

(6) LEDs Gateway

(7) 24 V power supply AUX

(8) SmartWire­DT connection (plug, 8­pole)

Table 12: Front view EU5C­SWD­PROFINET gateway
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5.2 Positions and meaning of the LEDs

5.2.1 Positions of the LEDs

(1) POW: System status

(2) APL: Application status

(3) Config.: Configuration status

(4) SWD: SmartWire­DT status

(5) SF: PROFINET IO system error

(6) BF: PROFINET IO bus error

(7) LINK for channel 0

(8) Receive/Transmit (RX/TX) for channel 0

(9) LINK for channel 1

(10) Receive/Transmit (RX/TX) for channel 1

Table 13: LEDs EU5C­SWD­PROFINET gateway
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5.2.2 Descriptions of the LEDs
LED Color State Meaning
POW
System status
Number in
picture: 
(1)

Duo LED yellow/green

yellow On Firmware and operating system are running.

(green/
yellow)

Flashing green/
yellow

Second Stage Bootloader is not able to load firmware. The device
needs to be sent­in for servicing.

(green) On Backup firmware is active. The gateway needs a firmware recovery as
described in chapter Firmware recovery via HTTP [} page 100].

(green) Flashing green ROM loader is not able to find bootable image. The device needs to be
sent­in for servicing.

(off) Off Power supply for device is missing or hardware defect.

APLApplication
status
Number in
picture: (2)

Duo LED red/green

(green) On The communication on PROFINET and SmartWire­DT is in cyclic data
exchange and the gateway function is executed.

(green) Flashing 2 s
off, 0.5 s on

Gateway is initialized, but the communication on PROFINET is not in
cyclic data exchange.

(green) Flashing 2 s
off, 0.5 s on,
0.5 s off, 0.5 s
on

Gateway is initialized, but the communication on SmartWire­DT is not
in cyclic data exchange.

(red) Flashing 2 s
off, 0.5 s on

Gateway is initialized, but the configuration for the communication
protocol on PROFINET is missing or in error.

(red) Flashing 2 s
off, 0.5 s on,
0.5 s off, 0.5 s
on

Gateway is initialized, but the configuration for the communication
protocol on SmartWire­DT is missing or in error.

(red) On Gateway has detected an error during the initialization: Missing
configuration, error in configuration or internal error.

Config.
Configuration
status
Number in
picture: (3)

Duo LED red/green

(green) On The planned configuration complies with the gateway target
configuration. Data exchange between Gateway and PLC via
PROFINET takes place.

(green) Flashing The planned configuration does not comply with the gateway target
configuration, but is compatible with it. Data exchange between
gateway and PLC via PROFINET takes place.

(red) On The planned configuration and the gateway target configuration are
not compatible. Nodata exchange between gateway and PLC via
PROFINET.

(off) Off No communication with the PROFINET IO controller or the gateway
does not contain a project configuration.

Table 14: Descriptions of the LEDs
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LED Color State Meaning
SWDStatus
SmartWire­DT
Number in
picture: (4)

Duo LED red/green/orange(orange = red/green at the same time)

(green) On The current actual configuration complies with the gateway target
configuration. Data exchange between gateway and SmartWire­DT
slaves takes place.

(red) Flashing A necessary SmartWire­DT slave is missing or the gateway target
configuration does not comply with the actual configuration. Nodata
exchange between gateway and SmartWire­DT slaves.

(green) Flashing Slave addressing is active (after power On or the download of a
planned configuration with empty modules). Nodata exchange
between gateway and SmartWire­DT slaves.

(red) On Short­circuit on the 15 V power supply or no SmartWire­DT slave is
connected. Nodata exchange between gateway and SmartWire­DT
slaves.

(orange) Flashing After having pressed the configuration button: The gateway reads the
current actual configuration and stores it as target configuration.

SFPROFINET
System error
Number in
picture: (5)

Duo LED red/green

(red) On Watchdog timeout; channel­, generic or extended diagnosis present;
system error.

(red) Flashing
cyclically at 2
Hz (for 3 sec.)

DCP signal service is initiated via the bus.

(off) Off No error

BFPROFINET
Bus error
Number in
picture: (6)

Duo LED red/green

(red) On No configuration; or low speed physical link; or no physical link.

(red) Flashing
cyclically at 2
Hz

No data exchange.

(off) Off No error.

LINK/RJ45 Ch0
& Ch1
Numbers in
picture:
(7) & (9)

LED grün

(green) On Gateway has connection to Ethernet.

(off) Off Gateway has no connection to Ethernet.

RX/TX/RJ45
Ch0 & Ch1
Numbers in
picture:
(8) & (10)

LED gelb

(yellow) Steady on orflashing
Gateway sends/receives Ethernet frames.

Table 15: Description of the LEDs (2)
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5.3 Pinning of the Real­Time Ethernet interface
The following picture shows the pinning of the PROFINET interface of the
gateway.

Figure 2: Pinning of the Ethernet interface (RJ45)

Pin Signal Description
1 TX + Transmit Data +
2 TX – Transmit Data –
3 RX + Receive Data +
4 TERM Bob Smith Termination
5 TERM
6 RX – Receive Data –
7 TERM Bob Smith Termination
8 TERM
Table 16: Ethernet interface channel 0 and channel 1 pin assignment (RJ45)

Note:
The Ethernet interface supports auto crossover.
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5.4 Device type label
Each EU5C­SWD­PROFINET Gateway carries a device type label, which
provides the following information:

(1) Version of firmware (at time of delivery)
(2) Information on power supply for switching devices
(AUX)

(3) Information on power supply for Gateway and Smart­
Wire­DT slaves (POW)

(4) Information on wire gauge of power supplies
(5) Operating ambient temperature
(6) Device type name
(7) Part number
(8) Hardware revision number
(9) Serial number

Table 17: Device type label EU5C­SWD­PROFINET

Note:
The version of the loaded firmware is indicated on the device type
label only since version 1.4.x.x. Older gateways do not carry this
information on the label.
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6 Getting started
The following table provides an overview of the steps necessary for
installing and commissioning the EU5C­SWD­PROFINET gateway.

Note:
The gateway is shipped with its firmware already loaded.
If your gateway is running with a firmware version older than 1.4.x.x,
it is strongly recommended to update the firmware and to use the
version of the device description file specified in section Versions of
devices, firmware, software, drivers and device description file [}
 page 7]. For information on how to update the firmware of the
gateway, please refer to chapter Updating firmware [} page 95].

# Step For details refer to
1 Install gateway Chapter Installing gateway [} page 34]
1.1 Take safety precautions Section Safety messages [} page 34]
1.2 Mount gateway onto top hat rail Section Mounting gateway onto top hat rail [} page 35]
1.3 Connect gateway to power supply Section Connecting gateway to power supply [} page 38]
1.4 Connect gateway to SmartWire­DT network Section Connecting SmartWire­DT  [} page 40]
1.5 Connect gateway to PROFINET IO network Section Connecting PROFINET IO [} page 41]
2 Commission gateway Chapter Commissioning gateway [} page 43]
2.1 Configure SmartWire­DT network in gateway Section Configuring SmartWire­DT network in gateway [}

 page 43]
2.2 Configure a PROFINET IO project for gateway Section Configuring gateway in PROFINET IO network [}

 page 46]
2.2.1 Import GSDML device description file in

programming tool
Section GSDML device description file [} page 46]
Example for STEP 7: Section Import GSDML device
description file [} page 51]

2.2.2 Configure gateway in PROFINET IO project Example for STEP 7: Section Step­by­step instructions for
configuring gateway with STEP 7 [} page 49]

2.2.3 Load PROFINET IO configuration to Controller/
PLC

Example for STEP 7: Section Step­by­step instructions for
loading PROFINET IO configuration to S7­300 PLC [} page
70]

2.3 Program Controller/PLC Example for STEP 7: Section Step­by­Step Instructions for
Programming in STEP 7: Display I/O Data [} page 74]

Table 18: Getting Started
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7 Installing gateway

7.1 Safety messages

Electrical shock
Please observe the following safety messages when you install and handle
the gateway:
Ø First disconnect the power plug of the device.
Ø Make sure that the power supply is off at the device.
Ø Cover or enclose neighboring units that are live.

Electrostatic Sensitive Device
The gateway is sensitive to electrostatic discharge, which can cause
internal damage and affect its normal operation. Therefore adhere to the
necessary safety precautions for components that are vulnerable to
electrostatic discharge, when you install or handle the gateway:
Ø Do not touch the metal pins of the connectors of the gateway.
Ø Touch a grounded object to discharge potential static.
Ø Wear an approved grounding wrist strap.
Ø If available, use a static­safe workstation.
Ø When not in use, store the device in an appropriate static­safe
packaging.
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7.2 Mounting gateway
No tools are required for mounting the EU5C­SWD­ETHERCAT Gateway
onto a top hat rail. The back of the gateway (1) carries a spring­fitted bolt
(2) by which the gateway can be clamped to the rail (3).

Figure 3: Mounting principle of the gateway

7.2.1 Mounting gateway onto top hat rail
To mount the gateway onto the top hat rail, proceed as follows:

 Electrical shock: Make sure that the gateway is disconnected
from any power supply! Cover or enclose neighboring units that are live!
Ø Tilt the gateway slightly and hook it into the upper
railing from above, thereby pushing down the
gateway with slight force, in order to overcome the
resistance of the spring in the bolt.

Hook gateway to upper railing
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Ø Keep on pushing the gateway downwards and tilt it
back into vertical position, thereby hooking the
gateway into the lower railing.

Hook gateway to lower railing

Ø Let go of the gateway. The spring inside the bolt
automatically pushes the gateway upwards into
the railings, thereby fixing the gateway to the top
hat rail.

Gateway is clamped to top hat rail
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7.2.2 Removing gateway from top hat rail
To remove the gateway from the top hat rail, proceed as follows:

 Electrical shock: Make sure that the gateway is disconnected
from any power supply! Cover or enclose neighboring units that are live!
Ø Push down the gateway with slight force (to
overcome the resistance of the spring in the bolt),
then unhook the gateway first from the lower railing
and then from the upper railing.

Unhook gateway
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7.3 Connecting gateway to power supply

Danger of lethal injuries by unexpected starting up of motors or
machinery!
If you have already integrated devices into a system, secure the operating
range of any connected parts of the system against access, so that nobody
is endangered by motors or machinery starting up unexpectedly.

Danger of unsafe operation of the system
In safety­relevant applications the power supply providing power for the
SmartWire­DT system must feature a PELV power feed module (protective
extra low voltage).

Danger of unsafe operation of the system
You must take safety precautions (emergency switching off) in the external
circuitry of the gateway and any power modules type EU5C­SWD­PF1­1 or
EU5C­SWDPF2­1 that are used. To do so, plan to switch off the power
supply to the contactor coils AUX.

Important:
Please take into consideration the total power consumption of your
SmartWire­DT network and, if necessary, plan for an additional
feeder module EU5C­SWD­PF2. You can find information on the
power consumption in the operating manuals of the SmartWire­DT
devices.

Ø Connect the 24 V DC voltage to the POW terminals on the front side of
the gateway. The POW connection provides the voltage for the gateway
itself and for the SmartWire­DT slave electronics.

Note:
For the 15 V supply of the SmartWire­DT slaves, the gateway
contains an additional power feed module with an amperage of
0.7 A.
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Ø If necessary, connect the 24 V DC voltage for the contactor coils to the
AUX terminals on the front side of the gateway.

Figure 4: Gateway power supply

Note:
The AUX supply is required if any switching devices are also to be
connected, for example, via the DIL­SWD­32­001/002 SmartWire­
DT slaves. The AUX connection provides the supply for activating
the contactor coils.
This supply must be protected by an automatic circuit­breaker (3A
gG/gl or 3 A miniature circuit­breaker with a Z characteristic).
If switching devices with an activation power greater than 3 A are
connected, an additional feeder module EU5C­SWD­PF1 or EU5C­
SWD­PF2 must be used.

Potential conditions between the components

The entire SmartWire­DT system operates on a common supply voltage.
Provide a common star point for the earth wiring. In this way, the various
slaves in the SmartWire­DT system will not be electrically isolated from one
another. 
The PROFINET network and the SmartWire­DT system are electrically
isolated from one another.
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7.4 Connecting SmartWire­DT
Ø Connect the SmartWire­DT network to the gateway. To do so, use the
SmartWire­DT cable SWD4­100LF8­24 and the SWD4­8MF2 relevant
blade terminal or prefabricated cables of type SWD4­(3/5/10)F8­24­2S.

Figure 5: Connecting SmartWire­DT to gateway

Device destruction
Switch off the power supply before you are reconnecting slaves in the
SmartWire­DT system or reconnecting the ribbon cable connection.
Otherwise the SmartWire­DT slaves can be destroyed!

Detailed instructions on adapting the SmartWire­DT external device
plug (SWD4­8SF2­5) to the 8 pole Smart­Wire­DT cable are
provided in chapter Fitting external device plugs SWD4­8SF2­5 of
the manual SmartWire­DT – The System, MN05006002Z­EN
(previously AWB2723­1617en).
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7.5 Connecting PROFINET IO
Ø Connect the RJ45 plug of the PROFINET IO cable to one of the
Ethernet connectors on the gateway.

Figure 6: Connecting PROFINET IO to Gateway

Please observe the following notes on PROFINET IO cabling:
· Do not use hubs.
· Use switches only if the switch supports “Priority Tagging” and LLDP
(100 MBit/s, Full Duplex).

· Maximum cable length in a segment is 100 meters.

Please also observe the following note on the cabling of the
PROFINET IO Controller:
· Connect only ports with each other which have different cross­over
settings. Otherwise, a connection between the devices cannot be
established. If the port settings of the PROFINET IO Controller are not
set to AUTO, then Port0 is switched uncrossed and Port1 crossed.
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7.6 EMC­Conformant Wiring of the Network
Undesired faults can occur on the bus due to electromagnetic interference. 
This can be minimized beforehand by the implementation of suitable EMC
measures. These include:
· EMC­conformant system configuration,
· EMC compliant cable routing,
· Measures that do not allow the occurrence of large differences in
potential and

· correct installation of the PROFINET system (cables, connection of the
bus connectors, etc.)

The effects of electromagnetic interference can be significantly reduced by
fitting a shield.

For detailed information on this, please refer to the PROFINET
Installation Guideline for Cabling and Assembly, published by the
PROFIBUS Nutzerorganisation e.V., Order No: 8.072.
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8 Commissioning gateway
Before switching on, check whether the power supply for the gateway is
connected correctly. The configuration and installation of the SmartWire­DT
network must also have been carried out correctly (with all slaves
connected).

Commissioning takes place in several steps.
1. Putting the SmartWire­DT network into operation.
2. Create a connection to the PROFINET IO network.
3. 3. Configure PROFINET IO network and load configuration to PLC
(PROFINET IO Controller).

4. Write code for controller program and load it to PLC (PROFINET IO
Controller).

Danger of lethal injuries by unexpected starting up of motors or
machinery!
If you have already integrated devices into a system, secure the operating
range of any connected parts of the system against access, so that nobody
is endangered by motors or machinery starting up unexpectedly.

8.1 Configuring SmartWire­DT network in gateway
Before the gateway can exchange data with the PLC, a valid SmartWire­DT
network configuration (a so­called gateway target configuration) has to be
stored in the gateway. This is compared with the current configuration
(actual configuration) each time the gateway is restarted. If the gateway
ascertains in this process that a SmartWire­DT slave cannot be reached or
a wrong slave type is determined, the SmartWire­DT network will not go
into operation (to be precise, this is dependent on the network
configuration). Reading of the SmartWire­DT network configuration takes
place by pressing the configuration button on the gateway (for the position
of the configuration button, see section Device picture [} page 27]) All
SmartWire­DT slaves are re­addressed in ascending order in the process.

This process may only take place in the case of:
· initial commissioning,
· the replacement of a defective slave or
· a change to the configuration

Hazard of device damage by disruption of voltage supply while
creating target configuration!
Do not interrupt the voltage supply while creating the target configuration of
the gateway. Power failure during a writing process in the file system can
cause severe malfunctioning of the device.
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If a SmartWire­DT slave has failed, the SmartWire­DT network can still be
operated with the remaining slaves, depending on the configuration setting
(even after a repeat power up of the gateway). The failure is reported to the
application.

Important:
If there is a faulty configuration and the configuration button is
pressed, only the slaves up to the failed device are addressed and
stored. Use of the remaining slaves is not possible until the
defective slave has been replaced and the configuration has been
read in again by pressing the configuration button.

8.1.1 Reading the SmartWire­DT configuration
If you startup the gateway for the first time, or if you have replaced a
SmartWire­DT slave or changed the setup of the SmartWire­DT network in
some other way, you have to initiate a reading of the SmartWire­DT
configuration.

8.1.1.1 Prerequisites

Prerequisites for reading the configuration are:
· All SmartWire­DT slaves are connected to the SmartWire­DT line.
· The SmartWire­DT network is connected to the gateway.
· The voltage POW is applied to the coupling unit and the power LED
POW is on.

· The voltage AUX is applied (if necessary).
· The SmartWire­DT status LEDs of the SmartWire­DT slaves are on or
are flashing.

Note:
Disconnect the PROFINET IO network from the gateway by
removing the RJ45 plug from the Ethernet interface of the gateway,
before pressing the configuration button.
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8.1.1.2 Step­by­step instructions
Ø Press the configuration button on the gateway for at least two seconds
(for the position of the configuration button, see figure in section Device
picture [} page 27]. 
Take care to push the button properly. You have to feel and overcome a
slight resistance when pushing the button into the gateway, otherwise
the button won’t trigger.

Ê The SmartWire status LED on the gateway begins to flash orange. The
SmartWire­DT status LEDs on the SmartWire­DT slaves also flash. All
slaves are addressed in sequence, the complete configuration is stored
retentively as gateway target configuration.

Hazard of device damage by disruption of voltage supply while
creating target configuration!
Do not interrupt the voltage supply while creating the target configuration of
the gateway. Power failure during a writing process in the file system can
cause severe malfunctioning of the device.

ð The gateway then restarts.

8.1.2 Switching on gateway when target configuration is stored
If a configuration is stored in the gateway, each time the supply voltage is
switched on, it is checked whether the slaves actually found on the network
comply with the stored gateway target configuration.

The result of the check is indicated by the SmartWire­DT status LED on the
gateway (for the position of the LED, see section Positions of the LEDs [}
 page 28]):

LED Color State Meaning
SWDStatus
SmartWire­DT
Number in
picture: (4)

Duo LED red/green/orange(orange = red/green at the same time)

(green) On The current actual configuration complies with the gateway target
configuration. Data exchange between gateway and SmartWire­DT
slaves takes place.

(red) Flashing red A necessary SmartWire­DT slave is missing or the gateway target
configuration does not comply with the actual configuration. Nodata
exchange between gateway and SmartWire­DT slaves.

(green) Flashing Slave addressing is active (after power On or the download of a
planned configuration with empty modules). Nodata exchange
between gateway and SmartWire­DT slaves.

(red) On Short­circuit on the 15 V power supply or no SmartWire­DT slave is
connected. Nodata exchange between gateway and SmartWire­DT
slaves.

(orange) Flashing After having pressed the configuration button: The gateway reads the
current actual configuration and stores it as target configuration.

Table 19: SWD LED
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8.2 Configuring gateway in PROFINET IO network

8.2.1 GSDML device description file
In the PROFINET engineering tool of the PLC programming system, the
EU5C­SWD­PROFINET Gateway is integrated as PROFINET IO Device –
i. e. as slave device. For this, a device description file (GSDML file)
containing a standardized description of the gateway is necessary.

You will find the GSDML file on the product DVD in the EDS\EU5C­SWD­
PROFINET\Vx.x.x.x. directory. You can also download the latest
version of a GSDML file from our website www.hilscher.com under
Products> Partner Products > SmartWire­DT> EU5C­SWD­PROFINET
> Downloads.

Copy the relevant GSDML files together with the relevant bitmap files to the
relevant directory of your PROFINET engineering tool or use the import
function of the tool. For further information on this, please refer to the
documentation of your engineering tool.

8.2.2 Creating communication with PROFINET IO
If a data interchange is possible between the SmartWire­DT slaves and the
gateway, in principle also communication between the gateway and the
controller can be established via PROFINET IO.
Ø Connect the gateway to the PROFINET IO bus.
Ø Load the PROFINET IO configuration and possibly a controller program
to the PLC.

On uploading the PROFINET IO configuration/program from the
engineering tool to the PLC, the configuration of the entire PROFINET IO
network is transferred to the PROFINET IO Controller (master). The
PROFINET IO Controller then transfers the planned SmartWire­DT
configuration, which is included in the PROFINET IO configuration, to the
gateway, where it is being tested. If the planned configuration complies with
the stored gateway configuration, all status LEDs indicate a green
continuous light. Any errors that occur are indicated via the Application
status LED and the Config status LED.
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LED Color State Meaning
APLApplication
status
Number in
picture: (2)

Duo LED red/green

(green) On The communication on PROFINET and SmartWire­DT is in cyclic data
exchange and the gateway function is executed.

(green) Flashing 2 s
off, 0.5 s on

Gateway is initialized, but the communication on PROFINET is not in
cyclic data exchange.

(green) Flashing 2 s
off, 0.5 s on,
0.5 s off, 0.5 s
on

Gateway is initialized, but the communication on SmartWire­DT is not
in cyclic data exchange.

(red) Flashing 2 s
off, 0.5 s on

Gateway is initialized, but the configuration for the communication
protocol on PROFINET is missing or in error.

(red) Flashing 2 s
off, 0.5 s on,
0.5 s off, 0.5 s
on

Gateway is initialized, but the configuration for the communication
protocol on SmartWire­DT is missing or in error.

(red) On Gateway has detected an error during the initialization: Missing
configuration, error in configuration or internal error.

Table 20: APL LED

Prerequisite for data interchange is that the PROFINET configuration drawn
up in the PROFINET engineering tool (= planned configuration) complies
with the target configuration actually available on the gateway. The result of
this check is signaled on the gateway by the SmartWire­DT configuration
LED:

LED Color State Meaning
Config.
Configuration
status
Number in
picture: (3)

Duo LED red/green

(green) On The planned configuration complies with the gateway target
configuration. Data exchange between Gateway and PLC via
PROFINET takes place.

(green) Flashing The planned configuration does not comply with the gateway target
configuration, but is compatible with it. Data exchange between
gateway and PLC via PROFINET takes place.

(red) On The planned configuration and the gateway target configuration are
not compatible. Nodata exchange between gateway and PLC via
PROFINET.

(off) Off No communication with the PROFINET IO controller or the gateway
does not contain a project configuration.

Table 21: Config LED

SmartWire­DT Gateway | EU5C­SWD­PROFINET
DOC120304UM07EN | Revision 7 | English | 2015­06 | Released | Public

© Hilscher 2012 – 2015



Commissioning gateway 48/112

8.3 Example: Using STEP 7 to create a gateway project in
PROFINET IO network controlled by S7­300 PLC

8.3.1 Overview
The following example shows how to use the STEP 7 programming
software to configure and program the EU5C­SWD­PROFINET Gateway in
a PROFINET IO network which is controlled by a S7­300 PLC.

For this example, you need the following hard­ and software:
· PROFINET engineering tool: Programming device or PC with installed
STEP 7 software (= programming system)

· GSDML device description file for EU5C­SWD­PROFINET Gateway
· S7­300 PLC
· EU5C­SWD­PROFINET gateway
· PROFINET IO network
· SmartWire­DT network with slaves

To create and implement the gateway project, the following steps have to
be performed in STEP 7:
1. Create new project
2. Import GSDML file
3. Configure PROFINET IO Controller (S7­300 PLC)
4. Configure PROFINET IO network
5. Configure gateway in PROFINET IO
6. Configure SmartWire­DT slaves in PROFINET IO
7. Save and compile configuration
8. Load configuration to S7­300 PLC (PROFINET IO Controller)
9. Program controller
10. Load controller program to S7­300 PLC (PROFINET IO Controller)
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8.3.2 Step­by­step instructions for configuring gateway with STEP 7

8.3.2.1 Create project in STEP 7
1. Start STEP 7 SIMATIC Manager.
Ø In the Windows Startmenu, choose All Programs > SIMATIC >
SIMATIC Manager.

Ê The SIMATIC Manager opens.
Ø If the STEP 7 Wizard: “New Project” appears, close the wizard by
clicking the Cancelbutton.

2. Create new project.
Ø In the menu, choose File> New.
Ê The New Project dialog box opens.

Figure 7: Create new project in SIMATIC Manager

Ø In the User projects tab, use the Namefield to enter the name of your
project. In the Typedrop­down list, select Projectentry.

Ø Click OK button.
Ê The New Project dialog box closes, and a window containing the new
project opens.

3. Add PLC to the project.
Ø In the project tree of the project window (in the left part of the project
window), select your new project. In the menu bar, choose Insert>
Station> SIMATIC 300 Station.
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Ê The PLC is displayed in the project window.

Figure 8: PLC added to the project

4. Open Hardware Configuration.
Ø In the project tree, select SIMATIC 300(1) symbol, then double­click
Hardwaresymbol in the right part of the project window.

Ê The HW Config(Hardware Configuration) window for the project opens.

Figure 9: Hardware Configuration Window
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8.3.2.2 Import GSDML device description file
Ø In the menu bar of the HW Configwindow, choose Options > Install
GSD File…

Ê TheInstall GSD Filesdialog box opens:

Figure 10: Install GSD Files dialog box

Ø Choose the directory where the GSDML file you want to install is stored.
In the drop­down list located next to the Install GSD Filesentry, select
from the directory entry, then click Browse… button.

Ê The Windows Search Folder dialog opens.
Ø Navigate to the relevant directory, select relevant folder and click OK
button.

Ê The Search Folder dialog closes, and in the Install GSD Files dialog
box all GSD and GSDML files stored in that folder are displayed:

Figure 11: Select GSDML File
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Note:
Usually the GSDML file is delivered together with a bitmap file
containing an icon, which symbolizes the gateway in the GUI of the
programming system. This bitmap file must be stored in the same
folder as the GSDML file, so that it can automatically be installed
together with the GSDML file. Please note, that this bitmap file is
not displayed in the Install GSD Files dialog box, even if it’s
actually there. Therefore, if you are in doubt, use the Windows
Explorer to check whether the bitmap file is really present in the
chosen folder.

Ø Select the relevant GSDML file, then click Install button.
Ê The GSDML file is installed. If an older version of the GSDML file has
been installed before, this older file is transferred to a backup directory.

Ø Acknowledge all messages by clicking Yes or OK. Click Close button to
quit the Install GSD Files dialog box.

Ê In the Hardware Catalog of the HW Config window, the EU5C­SWD­
PROFINET Gateway is displayed under PROFINET IO > Additional
Field Devices > Gateway.

Note:
If the Hardware Catalog is not visible by default, you can open it in
the menu bar of the HW Config window by choosing View >
Catalog.

Figure 12: Installed GSDML File
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8.3.2.3 Configure PROFINET IO Controller
1. Add rail (carrier rack) for IO Controller (PLC).
Ø In the Hardware Catalog of the HW Config window, under SIMATIC
300 > RACK­300, choose Rail object, and drag and drop it into the
configuration window.

Figure 13: Added Rail

Ê The rail is displayed in the configuration window.

2. Add power supply module for IO Controller (PLC).
Ø In the Hardware Catalog of the HW Config window, under SIMATIC
300 > PS­300, choose the appropriate power module, e. g. PS 307 10A,
and drag and drop it onto Slot 1 of the rail in the configuration window.

Note:
Once you have selected an object in the hardware catalog, all slots
in the configuration window onto which the object can be dropped,
are highlighted in a green color. This helps you to find the right slot.
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Figure 14: Added Power Module

Ê In the configuration window, the added power module is displayed in the
rail.

3. Add CPU for IO Controller (PLC).
Ø In the Hardware Catalog of the HW Config window, choose the CPU
you are using, e. g. SIMATIC 300 > CPU­300 > CPU 315­2 PN/DP >
6ES7 315­2EH13­0AB0 > V2.6, and drag and drop it onto Slot 2 of the
rail in the configuration window.
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Ê On dropping the CPU onto the slot, the Properties – Ethernet
Interface sheet automatically opens:

Figure 15: Add CPU

Ø In the Parameters tab of the Properties – Ethernet Interface sheet,
enter IP address and Subnet mask or accept the preset default values.
You can also set the IP address later during the next step, when you
add a PROFINET IO network to the project.

Note:
Consult you network administrator about IP addresses, if you intend
to use your company’s Ethernet network.

Ø Click OK button, to close the Properties – Ethernet Interface sheet.
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Ê After the Properties – Ethernet Interface sheet is closed, the added
CPU with its interfaces is displayed in the rail in the configuration
window:

Figure 16: Added CPU
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8.3.2.4 Configure PROFINET IO network
1. Add PROFINET IO network.
Ø In the configuration window, right­click the X2 PN­IO interface, then
choose Insert PROFINET IO System from the context menu.

Ê The Properties – Ethernet Interface sheet, which you have already
seen in the previous step when you added the CPU, opens again. The
IP address and the Subnet mask are displayed in the Parameters tab
and can be changed here once again.

Figure 17: Add PROFINET IO (1)

2. Set parameters for PROFINET IO network.
Ø If necessary, change the values of the IP address and the Subnet
mask in the Parameters tab.

Ø In the Parameters tab, click New… button.
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Ê The Properties – New subnet Industrial Ethernet sheet opens:

Figure 18: Add PROFINET IO (2)

Ø In the Name field of the Properties – New subnet Industrial Ethernet
sheet, enter a new name for the network, or accept the preset default
name. Then click OK button.

Ê You are back in the Properties – Ethernet Interface sheet.
Ø In the Properties – Ethernet Interface sheet, click OK button.
Ê The Properties – Ethernet Interface sheet is closed, and in the
configuration window, the newly added PROFINET IO network is
depicted as PROFINET bus line.

Figure 19: Added PROFINET IO network
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8.3.2.5 Configure gateway in PROFINET IO
1. Add gateway.
Ø In the Hardware Catalog, under PROFINET IO > Additional Field
Devices > Gateway> EU5C­SWD, select the EU5C­SWD­PROFINET
object and drag it into the configuration window, then drop it below the
PROFINET bus line, which you have added in the previous step.

Ê In the configuration window, the PROFINET bus line is depicted with the
connected gateway:

Figure 20: Added gateway

2. Set device name of gateway in PROFINET IO network.
Ø In the upper part of the configuration window, double­click the gateway
symbol.
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Ê The Properties sheet of the gateway opens:

Figure 21: Set device name of gateway

Ê In the Device name field of the General tab, you see the preset name
of the gateway, which the STEP 7 software has taken over from the
imported GSDML file. The PROFINET IO controller (the PLC) uses this
name to address the gateway in the network.

Ø Keep the preset name, if you intend to use only one EU5C­SWD­
PROFINET Gateway in your PROFINET network. If you intend to use
more than one gateway, you must define a unique new name for each
additional gateway. In that case you can keep the preset name for your
first gateway, but have to enter a new Device name in the
corresponding Properties sheets of the other gateways.

Important:
Please note that you need to define these new names not only
within the STEP 7 configuration, but that you also need to transfer
the new names onto the additional gateways and save them there,
in order to overwrite the preset standard name stored in each
gateway. Otherwise the additional gateways will not respond when
contacted by the PROFINET IO controller.
For information on how to change the device name on a gateway,
see section REPLACEME [} page 83]

Ø Click OK button to close the Properties sheet.
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Note:
If you have installed more than one version of a GSDML device
description file in the course of time, you can use the Change
Release Number… button in the General tab of the Properties
sheet to open a dialog box, in which you can choose an older
version of the GSDML file to be used to configure the gateway.
Older versions of GSDML files are moved to a backup directory
when new GSDML files are being imported to STEP 7, see section
REPLACEME [} page 51].

3. Define IP address for gateway in PROFINET IO.
Ø In the upper part of the configuration window, right­click the gateway
symbol, then choose Edit PROFINET IO System IP address from the
context menu.

Ê The Edit IP Addresses dialog box opens:

Figure 22: Set IP address of gateway

Ø Accept the IP address determined by the PROFINET IO controller, or
click the IP Address field and enter a new address.

Ø Click OK button to close Edit IP Addresses dialog box.
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4. Set further parameters of gateway.
Ø In the upper part of the configuration window, select the gateway
symbol [position (1)] , then double­click the gateway entry on Slot 0
[position (2)] in the lower part of the configuration window.

Figure 23: Set further gateway parameters (1)

Ê The Properties sheet opens.

Note:
The gateway has two different Property sheets in STEP 7. One
opens, if you double­click on the gateway symbol [position (1)] in
the upper part of the configuration window, the other opens if you
double­click the gateway entry on Slot 0 [position (2)] in the lower
part of the configuration window.

In the General tab, you can enter a comment:

Figure 24: Set further gateway parameters (2)
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Ø Click the Comment field and enter your text.
Ê After closing the Properties sheet, the text will be displayed in the
Comment column in the lower part of the configuration window.

In the Addresses tab, you can accept or change the preset diagnostic
address of the gateway.

Figure 25: Set diagnostic address of gateway

Ø Click the Diagnostic address field and enter the new address.

In the Parameters tab, you can set the application parameters of the
gateway in regard to its function as master in the SmartWire­DT network.

Figure 26: Set application parameters of gateway
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Ø In the Value column, click the entry you want to change. As soon as
you click a value, a drop­down list opens, in which you can select other
values.

You can set the following parameters:
Parameter Value Meaning
Baudrate SmartWire­DT 125 kBit/s The Baud rate of the SmartWire­DT Network

250 kBit/s
Compatible devices allowed No The planned SmartWire­DT slaves in the PROFINET

IO configuration must comply 100 % with the
SmartWire­DT slaves of the stored gateway target
configuration. If not, no data interchange takes place
with the PROFINET IO controller.

Yes Data exchange takes place, if the connected
SmartWire­DT slaves are different but compatible
with the planned SmartWire­DT slaves in the
PROFINET IO configuration. This is indicated by the
Config LED on the gateway.

All slaves optional Defined for each slave Specification is performed individually for each
SmartWire­DT slave.

Yes Data transmission to the PROFINET IO also takes
place for a random number of failed SmartWire­DT
slaves. The setting in the module parameters of the
SmartWire­DT slaves has no effect. See table
Application Parameters of Slave in the following
section.

Delay between cyclic
exchange (ms)

0 Reserved option, other settings currently not
supported.

Table 22: Application parameters of gateway

Ø Click OK button to close the Properties sheet.
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8.3.2.6 Configure SmartWire­DT slaves in PROFINET IO
1. Add SmartWire­DT slaves.

Note:
If you are using a project­specific GSDML device description file
which was created by the SWD­Assist software and which contains
preconfigured SmartWire­DT slaves, you don’t need to add and
configure SmartWire­DT slaves as described in the subsequent
section. For information on project­specific GSDML files created
with SWD­Assist, please refer to the SWD­Assist online help.

Ø In the configuration window, select the gateway symbol.
Ø In the Hardware Catalog, select under PROFINET IO > Additional
Field Devices > Gateway > EU5C­SWD > EU5C­SWD­PROFINET >
Eaton a slave device of your SmartWire­DT network, e. g. EU5E­
SWD­2A2Ain the Input / Output modules folder, then drag it into the
lower part of the configuration window and drop it onto an appropriate
slot of the gateway, e. g. Slot 1. Slots, onto which the device can be
dropped, are highlighted in green color.

Ê In the lower part of the configuration window, the added SmartWire­DT
slave is displayed in the assigned gateway slot:

Figure 27: Added SmartWire­DT slave

Ø Add other SmartWire­DT slaves as necessary. Proceed as described
above. If you are not sure about the final SmartWire­DT topology, and
perhaps wish to add SmartWire­DT slaves later, you can add a
placeholder. For further information, see section Adding SmartWire­DT
slaves later [} page 82].
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Important:
Ø Observe the correct order of the SmartWire­DT slaves in the
SmartWire­DT network. The SmartWire­DT slaves must be
configured in PROFINET IO in the exact order according to their
arrangement in the installation.

Ø The universal module is not a valid SmartWire­DT slave and
must not be added to the project.

2. Configure SmartWire­DT slaves.
Ø In the upper part of the configuration window, select the gateway
symbol [position (1)], then double­click the slave entry, e. g. EU5E­
SWD­2A2A on Slot 1 [position (2)], in the lower part of the configuration
window.

Figure 28: Configure SmartWire­DT slaves.

Ê The Properties sheet opens.

In the General tab, you can accept or change the preset name of the
SmartWire­DT slave.
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Figure 29: Set properties of SmartWire­DT slave

Ø Click Name field and enter a new name, if necessary.

In the Addresses tab, you can accept or change the addresses, which are
reserved within the controller for the input and output data of the
SmartWire­DT slave.

Figure 30: Set I/O Addresses of SmartWire­DT slaves, EU5E­SWD­2A2A example

Note:
On adding a SmartWire­DT slave, the addresses are assigned
automatically by the system. The preset address value ensures that
the start address is within the process image of the inputs and
outputs.

Ø Click the Start field and enter a new start address, if necessary.

In the Parameters tab, you can set the application parameters of the
SmartWire device in regard to its function as slave in the SmartWire­DT
network. For example, you can parameterize the transient behavior for
each SmartWire­DT slave. This defines how the gateway is to respond if a
SmartWire­DT slave is not present. The standard setting is that all
SmartWire­DT slaves have to be available.
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Note:
The information as to whether a SmartWire­DT slave is available, is
also reported to the application via the diagnostics function, so that
you can respond there to the failure of an individual slave.

Figure 31: Set application parameters for SmartWire­DT slave, EU5E­SWD­2A2A example

Ø In the Value column, click the entry you want to change. As soon as
you click a value, a drop­down list opens, in which you can select other
values.

Which application parameters can be set here, depends on the individual
device characteristics of the SmartWire­DT slave.

For information on individual device characteristics, please refer to
the user manual of the corresponding SmartWire­DT slave provided
by the device’s manufacturer.
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For the EU5E­SWD­2A2A device you can set the following parameters:
Parameter Value Meaning
Presence of Device on SWD Device shall be present Data transfer to PROFINET takes place only if the

SmartWire­DT slave is present.
Device shall not be present Data transfer to PROFINET takes place, even if the

SmartWire­DT slave has failed or is not present.
Note: Parameter setting at this point only makes sense, if in the application parameters of the gateway the All slaves
optional parameter has been set to Defined for each slave. See table Application parameters of gateway in previous
section.
Replacement by universal
module

not allowed The SmartWire­DT slave may not be replaced by a
universal module.

allowed The SmartWire­DT slave may be replaced by universal
module M22­SWD­NOP(C).

Type of sensor input 0 Voltage (0­10V) Defines the type of sensor/actuator the SmartWire­DT
slave is using (current­ or voltage­based sensor/actuator)Current (0­20mA)

Type of sensor input 1 Voltage (0­10V)
Current (0­20mA)

Type of sensor output 0 Voltage (0­10V)
Current (0­20mA)

Type of sensor output 1 Voltage (0­10V)
Current (0­20mA)

Measurement update time 20 ms; 100 ms; 200 ms; 500
ms

Defines the refresh rate of readings

Averaging On; Off Switches averaging on/off
Table 23: Application parameters of slave

Ø Click OK button to close the Properties sheet.

8.3.2.7 Save and compile configuration

After you have finished to configure your PROFINET IO project, you must
save and compile the configuration before you can upload it to your
PROFINET IO controller, i. e. your S7­300 PLC.
Ø In the menu bar of the HW Config window, choose Station > Save and
Compile.

Ê The hardware configuration is saved and compiled.
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8.3.3 Step­by­step instructions for loading PROFINET IO configuration to
S7­300 PLC

Prerequisites
· The S7­300 PLC is connected to power supply
· The S7­300 PLC is connected to the programming device/PC with
installed STEP 7 software

Step­by­step instructions
1. Set up PG/PC interface in STEP 7.
Ø In the menu bar of the SIMATIC Manager on your programming device/
PC, choose Options > Set PG/PC Interface…

Ê The Set PG/PC Interface dialog box opens:

Figure 32: Set PG/PC Interface (1)

Ø In the Interface Parameter Assignment Used list of the Access Path
tab, select the network interface card you are using on your
programming device/PC.

Ø Click Properties… button.
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Ê The Properties sheet for the selected network interface card opens:

Figure 33: Set PG/PC Interface (2)

Ø In the IE­PG Access tab, select Assign IP addresses unique to the
project option, then click OK button.

Ê You are back in the Set PG/PC Interface dialog box.
Ø Click OK button, to take over the setting of the PG/PC interface.

2. Load configuration to S7­300 PLC.
Ø Open the HW Config window for the Project.
Ø In the menu bar of the HW Config window, select PLC > Download…
Ê The Select Target Module dialog box opens:

Figure 34: Select Target PLC

Ø In the Module list, select the target module (i. e. the CPU of the PLC),
then click OK button.
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Ê The Select Node Address dialog box opens:

Figure 35: Select Node Address (1)

Ê The CPU of the PLC is not yet displayed in the Accessible Nodes list.
Ø Click View button.
Ê The programming device/PC reads the MAC addresses of the
connected devices and displays them in the Accessible Nodes list.

Figure 36: Select Node Address (2)

Ø In the Accessible Nodes list, select the row featuring the MAC address
of the CPU, then click OK button.
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Ê If no IP address has been assigned to the CPU before, the following
Download message appears:

Figure 37: Select Node Address (3)

Ø Answer the question, whether the IP address should be assigned, with
Yes.

Ê The IP address is assigned to the CPU, and the configuration is loaded
to the CPU of the PLC.

Ø In the menu bar of the HW Config window choose Station > Exit to
close HW Config. Answer the save prompt with Yes.
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8.3.4 Step­by­Step Instructions for Programming in STEP 7: Display I/O
Data

The following step­by­step instructions provide a simple programming
example for a PLC in STEP 7. It shows, how to monitor I/O data of the
M22­SWD­K22LED­B function element, which is a SmartWire­DT slave
controlled by a S7­300 PLC via the EU5C­SWD­PROFINET Gateway.
For this, you must first define a “data block” and an “organization block” and
load them to the PLC. Then you can visualize input and output data of the
M22­SWD­K22LED­B slave in STEP 7 by means of a “variable table”, and
send output data to the slave too.

Prerequisites
· You have already created, configured and loaded onto the S7­300 PLC
a project containing a certain SmartWire­DT slave (in this case the M22­
SWD­K22LED­B function element).

· Communication between PROFINET IO and SmartWire­DT network via
gateway runs smoothly, cyclic data is exchanged.

· The programming device/PC with installed STEP 7 software is
connected to the S7­300 PLC.

· You know the meaning of the input and output signals (e. g. the
assignment of certain Bits to certain operational states) of the
concerned SmartWire­DT slave.

You will find the parameters of individual SmartWire­DT devices
needed for programming in the corresponding user manual of the
device, e. g. in the Eaton user manual SmartWire­DT Units,
MN05006001Z­EN.

· The project is opened in the SIMATIC Manager.

Step­by­step instructions
1. Create data block.
Ø In the project tree, select the CPU.
Ø In the menu bar, choose Insert > S7 Block > Data block.

Figure 38: Project Window in SIMATIC Manager
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Ê The Properties sheet of the data block opens.

Figure 39: Create Data Block

Ø In the Name and type field of the General – Part 1 tab, enter the name
of the data block, e. g. „DB100“, then click OK button.

Ê The new data block is displayed in the Blocks node of the project
window.

Figure 40: Data Block Created

2. Edit data block.
Ø Select DB100 block.
Ø Double­click DB100 block or choose Edit > Open Object in the menu
bar.
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Ê The data block is opened in the editor:

Figure 41: Edit Data Block

Ø Define Name, Type and Initial value of the elements which represent
the input and output data.

Ø In the menu bar of the editor, choose File > Save, then close the editor.
3. Edit organization block.

Note:
You don’t need to create a new organization block (whereas you
had to create a new data block), because each project by default
already includes an OB1 organization block.

Ø In the Blocks node of the project window, select the OB1 organization
block.

Ø Double­click OB1 block or choose Edit > Open Object in the menu bar.
Ê If you open the OB1 organization block for the first time, the Properties
sheet of the block opens.

Ø Close the Properties sheet by clicking the OK button.
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Ê The organization block is opened in the editor:

Figure 42: Edit Organization Block

Ø Link the elements representing the input and output data of the
SmartWire­DT slave (i. e. DB100.DBB 1 and DB100.DBB 0 which you
have defined in the data block) to the I/O addresses which were
assigned to the SmartWire­DT slave when the project was being
configured in PROFINET IO. (See section SmartWire­DT­Teilnehmer in
PROFINET IO konfigurieren [} page 65]). If, for example, the value 256
was configured as I/O address, you must enter the programming code
as shown in the picture above.

Ø After you have entered the code, choose File > Save in the menu bar of
the editor, then close the editor.
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4. Load blocks to S7­300 PLC.

Note:
Before you can use a variable table to monitor input and output data
of the SmartWire­DT slave, you must download the code/blocks to
the PLC.

Ø In the project tree, select Blocks node.

Figure 43: Select Blocks Node in SIMATIC Manager

Ø In the menu bar of the SIMATIC Manager, choose PLC > Download.
Ê The code/blocks are loaded to the PLC.

5. Create variable table.
Ø In the project tree, select the CPU.

Figure 44: Selected CPU in Project Tree

Ø In the menu bar of the SIMATIC Manager, choose Insert > S7 Block >
Variable Table.
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Ê The Properties sheet of the variable table opens.

Figure 45: Create Variable Table

Ø In the Symbolic Name field of the General – Part 1 tab, enter the
name of the table, e. g. „ VAT_1“, then click OK button.

Ê The new variable table is displayed in the Blocks node of the project
window.

Figure 46: Variable Table Created

6. Edit Variable Table.
Ø Select the variable table
Ø Double­click the variable table or choose Edit > Open Object in the
menu bar.
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Ê The variable table is opened in the editor:

Figure 47: Edit Variable Table

Ø Fill in the Address and Display format columns as shown in the
picture above.

Ø In the menu bar of the editor, choose Table > Save.
7. Display I/O data.

Ø In the menu bar of the editor, choose Variable > Monitor, or click 
button in the toolbar of the editor.

Ê An online connection to the S7­300 PLC of this project is automatically
established, and signals currently sent by the SmartWire­DT slave are
displayed in the Status value column.

Figure 48: Monitor Input Data

If an event is triggered at the SmartWire­DT slave, the Status value of the
DB100.DBB 0 element (which represents the input data) changes:
Ø Push one of the buttons of the M22­SWD­K22LED­B slave device.
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Ê The corresponding Bit in the Status value column changes from 0 to 1.

Information on the assignment of certain Bits to certain operational
states, and other parameters needed for programming SmartWire­
DT slaves, can be found in the corresponding user manual of the
device, e. g. in the Eaton user manual SmartWire­DT Units,
MN05006001Z­EN.

If the Modify value of the DB100.DBB 1 element (which represents the
output data) is changed, an event at the SmartWire­DT slave can be
triggered:
Ø In the variable table, change the last Bit of the Modify value of the
DB100.DBB 1 element from 0 to 1.

Figure 49: Modify Value

Ø In the toolbar of the editor, click   Button.
ð The LED at the M22­SWD­K22LED­B slave device lights up.
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8.3.5 Adding SmartWire­DT slaves later
If you are not sure about the final SmartWire­DT topology, and may wish to
add SmartWire­DT slaves later, adding a placeholder (dummy module) in
the appropriate position in the SmartWire­DT network is recommended.
This is especially useful in STEP 7, since the HW Config tool does not
allow the adding of stations between occupied module locations.
Ø During configuration of the project in the engineering tool, position the
permanent SmartWire­DT slaves in the correct order and add the
Reserved (stored in the Other elements folder) element at the required
position.

Figure 50: Add Placeholder

Ê The placeholder reserves a SmartWire­DT slave address for the
SmartWire­DT slave which is to be added later.

Ø Save the project, transfer it to the PLC. Then switch the PLC to RUN
mode.

ð After the PROFINET IO configuration is received from the PLC, the
SmartWire­DT gateway addresses the slaves automatically, taking the
placeholder into account.
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8.3.6 Acyclical data communication S7­300 PLC
SmartWire­DT slaves – such as the PKE­SWD­32 module for the electronic
motor­protective circuit­breaker – also supply acyclical data in addition to
the cyclical data. The function blocks SFB52 RDREC (read record) and
SFB53 WRREC (write record) are used in STEP 7 for reading and writing
acyclical data.
The reference to the required slave is implemented with these function
blocks via the parameters ID and Index.

For further information on handling these function blocks, please
refer to the STEP 7 documentation.

The address of the SmartWire­DT slave, with which communication is to be
established, is set at the parameter ID. The Index parameter addresses the
V1 object. The first object is assigned number 1, the second 2 etc. On the
SmartWire­DT slave PKE­SWD­32, the object 1 supplies the current value I
rel

For further information on acyclical data communication, see section
Azyklische Kommunikation [} page 88].

8.3.7 Using STEP 7 to Assign Device Name or IP Address on the
Gateway

You can use STEP 7 and your programming device/PC to assign to your
gateway a new IP address or a new device name – independently from the
PROFINET IO configuration.

Prerequisites
· The gateway is connected to power supply.
· The gateway is connected via Ethernet to the programming device/PC
and the STEP 7 software.

· If you want to change the IP address of the gateway, the gateway must
not be in a state of cyclic data exchange with the PROFINET IO
controller.
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Step­by­step instructions
Ø Open HW Config window for the project.
Ø In the menu bar of the HW Config window, choose PLC > Ethernet >
Edit Ethernet Node.

Ê A blank Edit Ethernet Node dialog box opens:

Figure 51: Edit Ethernet Node (1)

Ø Below Nodes accessible online, click Browse… button.
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Ê The Browse Network dialog box opens. After a short while, all found
nodes are displayed:

Figure 52: Browse Network

Ø Select the entry for the gateway, then click OK button.

Note:
You can make the SF LED of the gateway flash, by clicking the
Flash button in this dialog box. This may help you, to physically
identify the gateway in a complex installation. Click Stop Flash
button to switch off the LED.
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Ê The Browse Network dialog box closes, and the current address
parameter of the gateway are taken over into the Edit Ethernet Node
dialog box:

Figure 53: Edit Ethernet Node (2)

Ø If you want to change the IP Address:
Enter the appropriate values in the IP address and Subnet mask
fields, then click Assign IP Configuration button.

Ê The IP address is transferred to the gateway and is stored in the
gateway.

Ø If you want to change the device name:
Enter the new name in the Device name field, then click Assign name
button.
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Ê The device name is transferred to the gateway and is stored in the
gateway.

Ø Click Close button to leave the Edit Ethernet Node dialog box.

Important:
Please note, that you also have to change the parameters in the
PROFINET IO configuration accordingly, and that you have to load
the adjusted configuration to the S7­300 PLC.
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9 PROFINET IO data communication

9.1 Acyclical communication

9.1.1 Address mapping
For acyclic communication, the read/write record services of the
PROFINET IO controller are in the EU5C­SWD­PROFINET Gateway
converted to SmartWire­DT read/write services and forwarded to the
SmartWire­DT slaves. An address mapping enables the PROFINET IO
Controller to access the SmartWire­DT slaves via the gateway.

The following figure depicts the mapping of the PROFINET IO slot, subslot
and index to SmartWire­DT slave and index.

Figure 54: Acyclic data address mapping

The gateway is addressed by the PROFINET IO name of station. This
makes is possible to address devices in the PROFINET IO network.

The numbering of the slots corresponds to the sequence of the SmartWire­
DT slaves, i. e. Slot 1 is assigned to the first slave etc.

The Subslot in PROFINET IO and in SmartWire­DT is always 1.

The Index is passed on unaltered from SmartWire­DT to PROFINET IO.
The meaning of the indexes depends on the individual SmartWire­DT
slaves.
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9.1.2 Error detection and error codes
The following figure shows at which points error detection is possible in
acyclic communication.

Figure 55: Acyclic data error detection

Errors detected in the gateway (PROFINET IO device) are reported as
normal PROFINET IO errors to the controller.

All errors, except addressing errors, which are detected on SmartWire­DT
(master or slave) are reported with error code 0xDE80A000 (read) or
0xDF80A100 (write) to the PROFINET IO controller.

Error detection by the gateway for read/write records:

An error code, e. g. 0xDE80B000, consists of an ErrorCode (DE =
IODReadRes), ErrorDecode (80 = PNIORW), ErrorCode1 (B0 = invalid
index) and ErrorCode2 (00 = not defined).
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Error codes for read requests

All error messages supported by the gateway concerning read requests
start with:
ErrorCode DE = IODReadRes = negative response to a read request,
followed by: 
ErrorDecode 80 = PNIORW = user error.
A description of ErrorCode1, which conveys the actual message, is
provided in the following table. ErrorCode2 is not defined.
Error message for
read request

ErrorCode1 Meaning

0xDE80A0xx A0 Application error in SmartWire­DT
0xDE80B0xx B0 Access invalid index
0xDE80B2xx B2 Access invalid slot/subslot
0xDE80B3xx B3 Access type conflict
0xDE80B4xx B4 Access invalid area / API
0xDE80B5xx B5 Access state conflict
0xDE80B6xx B6 Access denied
0xDE80B7xx B7 Access invalid range of a parameter/value
0xDE80B8xx B8 Access invalid parameter
0xDE80B9xx B9 Access invalid type
0xDE80BAxx BA Access backup
0xDE80BBxx BB Access user specific 7
0xDE80BCxx BC Access user specific 8
0xDE80BDxx BD Access user specific 9
0xDE80BExx BE Access user specific 10
0xDE80BFxx BF Access user specific 11
0xDE80C0xx C0 Resource constrain conflict
0xDE80C2xx C2 Resource busy
0xDE80C3xx C3 Resource unavailable
0xDE80C4xx C4 Resource not specified 1
0xDE80C5xx C5 Resource not specified 2
0xDE80C6xx C6 Resource not specified 3
0xDE80C7xx C7 Resource not specified 4
0xDE80C8xx C8 Resource user specific 12
0xDE80C9xx C9 Resource user specific 13
0xDE80CAxx CA Resource user specific 14
0xDE80CBxx CB Resource user specific 15
0xDE80CCxx CC Resource user specific 16
0xDE80CDxx CD Resource user specific 17
0xDE80CExx CE Resource user specific 18
0xDE80CFxx CF Resource user specific 19
Table 24: Acyclic data error codes for read requests
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Error codes for write requests

All error messages supported by the gateway concerning read requests
start with:
ErrorCode DF = IODWriteRes = negative response to a write request,
followed by: 
ErrorDecode 80 = PNIORW = user error.
A description of ErrorCode1, which conveys the actual message, is
provided in the following table. ErrorCode2 is not defined.
Error message for write
request

ErrorCode1 Meaning

0xDF80A1xx A1 Application error in SmartWire­DT
0xDF80B0xx B0 Access invalid index
0xDF80B1xx B1 Access invalid slot/subslot
0xDF80B2xx B2 Access type conflict
0xDF80B3xx B3 Access invalid area / API
0xDF80B4xx B4 Access state conflict
0xDF80B5xx B5 Access denied
0xDF80B6xx B6 Access invalid range of a parameter/value
0xDF80B7xx B7 Access invalid parameter
0xDF80B8xx B8 Access invalid type
0xDF80B9xx B9 Access backup
0xDF80BAxx BA Access user specific 7
0xDF80BBxx BB Access user specific 8
0xDF80BCxx BC Access user specific 9
0xDF80BDxx BD Access user specific 10
0xDF80BExx BE Access user specific 11
0xDF80BFxx BF Resource constrain conflict
0xDF80C1xx C1 Resource busy
0xDF80C2xx C2 Resource unavailable
0xDF80C3xx C3 Resource not specified 1
0xDF80C4xx C4 Resource not specified 2
0xDF80C5xx C5 Resource not specified 3
0xDF80C6xx C6 Resource not specified 4
0xDF80C7xx C7 Resource user specific 12
0xDF80C8xx C8 Resource user specific 13
0xDF80C9xx C9 Resource user specific 14
0xDF80CAxx CA Resource user specific 15
0xDF80CBxx CB Resource user specific 16
0xDF80CCxx CC Resource user specific 17
0xDF80CDxx CD Resource user specific 18
0xDF80CExx CE Resource user specific 19
0xDF80CFxx CF Application error in SmartWire­DT
Table 25: Acyclic data error codes for write requests
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9.2 Alarms and diagnosis controlled by the gateway

Figure 56: Diagnosis/Alarms

Alarms can be process alarms (PA) or diagnosis alarms (DA).

Process alarms are not issued by the gateway.

Diagnosis alarms can be:
· Return of submodule alarm
· Pull alarm
· Plug alarm
· Diagnosis

Return of submodule alarm

Alarm issued for every plugged SmartWire­DT slave when SmartWire­DT
returns from fail safe back to run normal state.

Pull alarm

Removal (pulling) or failure of a slave in the SmartWire­DT network leads to
a pull alarm in PROFINET IO.
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Plug alarm

Adding (plugging) or reinstalling a slave in the SmartWire­DT network leads
to a plug alarm only if the concerned slave device is included in the target
configuration.
Adding a slave which is not included in the target configuration will not
cause an alarm.

Note:
After having added a new slave device to the SmartWire­DT
network, you need to disconnect the PROFINET IO from the
gateway and read­in the new target configuration of the SmartWire­
DT network (see section Einlesen der SmartWire­DT­Konfiguration [
} page 44]). 
Please note, that you also need to add the new slave to the
PROFINET IO configuration.

Diagnosis

Diagnosis data issued by a SmartWire­DT slave is forwarded to the
PROFINET IO controller by the gateway using the following parameters:
Parameter Value
Slot Slot 0 = gateway reports

Slot 1…99 = individual SmartWire­DT slaves
SubSlot is always 1
Channel Number 0x8000 (= Submodule)
Channel Property is always 0
ChannelErrorType conveys the SmartWire­DT diagnosis code, see subsequent

table
Table 26: Diagnosis parameters
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ChannelErrorType (mapping of the SmartWire­DT diagnosis code in
PROFINET IO):

PROFINET IO
ChannelErrorType

SmartWire­DT
Diagnosis
code

Meaning Slot

0x0107 ­ SmartWire­DT is in state fail safe 0 (gateway)
0x0002 0x02 Supply voltage too low 1…99

(individual SWD slaves)0x0004 0x13 Short­circuit/overload at supply voltage
0x0005 0x01 Temperature too high
0x0007 0x17 Out­of­range high reading on at least one

temperature input
0x0008 0x18 Out­of­range low reading on at least one temperature

input
0x0013 0x03 No communication with host system
0x0100 0x14 Internal error
0x0101 0x10 At device M22: contact in undefined position / contact

in the middle position for longer than four seconds
0x0102 0x11 At device M22: contact short­circuit
0x0103 0x12 At device M22: contact resistance too high
0x0105 0x16 S0 power meters invalid
0x0106 0x15 No unambiguous position of the 1­0­A switch (auto/

manual switch) for more than four seconds
Table 27: Diagnosis ChannelErrorType

SmartWire­DT diagnosis code ≥ 0x19

Please note the following: SmartWire­DT diagnosis codes from 0x01 to
0x18 are mapped to ChannelErrorType values according to the table
above. 
SmartWire­DT diagnosis codes from 0x19 and higher are mapped to the
ChannelErrorType values according to the following scheme: The first
byte of the ChannelErrorType value carries the Vendor ID of the reporting
SmartWire­DT slave with the formula VendorID + 1, the second byte
transparently carries the unaltered SWD diagnosis code:

Example 1: Eaton has the Vendor ID = 01. If an Eaton SWD device reports
diagnosis code 0x19, this will thus be conveyed as ChannelErrorType =
0x0219.

Example 1: Phoenix has the Vendor ID = 02. If a Phoenix SWD device
reports diagnosis code 0x21, this will thus be conveyed as
ChannelErrorType = 0x0321.

For the meaning of the specific diagnosis codes, please consult the
user manual of the corresponding SmartWire­DT slave provided by
the device’s manufacturer.
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10 Updating firmware

10.1 Overview
The EU5C­SWD­PROFINET Gateway is shipped with its most recent
firmware already loaded. Since version 1.4.x.x, the version of the loaded
firmware is stated on the device type label. 
The integrated web server of the gateway provides a function to update the
firmware of the gateway by HTTP via its Ethernet interface. All you need is
a PC with an ordinary web browser, connected to the gateway via the
Ethernet network.

Hazard of device damage by disruption of voltage supply during
firmware update!
Do not interrupt the voltage supply while updating the firmware of the
gateway. Power failure during a writing process in the file system can
cause severe malfunctioning of the device.

Important:
Versions of firmware and device description files functionally belong
together. This means that after having updated the firmware, you
may also need to replace the old version of the GSDML file with a
new one.

Note:
In case of a missing or defective firmware (which is indicated by a
green POW LED), the “regular” firmware update process described
in this chapter is not working. In this case, proceed as described in
chapter REPLACEME.
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10.2 Prerequisites
· The gateway is connected to a power supply.
· The gateway is connected to an IP network via its Ethernet interface.
· PC with web browser connected to the IP network.
· The IP address of the gateway is compatible to the Ethernet subnet of
the PC.

· You know the IP address of the gateway and user name and password
needed for accessing the firmware update and reset functions of the
web server.
Default authentication parameters are: 
User Name: admin 
Password: admin

Note:
The current version of the firmware does not provide options to
customize the user authentication of the web server by creating own
groups, users or passwords.

IP address of gateway

On shipment, the default IP address of the gateway is 0.0.0.0.

In principle, the gateway receives its IP address temporarily from the
PROFINET IO controller via DCP protocol, and on each restart anew. A
statically stored IP address can also be assigned to the gateway by the
DCP protocol. The DCP protocol is standardized and usually supported by
PROFINET IO engineering tools. Apart from address assignment by the
PROFINET IO controller, you can assign the IP address of the gateway via
DCP by using one of the following tools:
· Hilscher Ethernet Device Configuration Tool.
An installer for this program is stored on the product DVD in the
directory Software\EnDeviceCfg. (It can also be installed by using
the menu of the Product DVD.) 
For information about how to use this tool, please refer to the operating
instruction manual Ethernet Device Configuration, which is stored on
the product DVD in the Documentation\english\1.Software
\Ethernet Device Setup Utility directory.

Note:
The IP address assigned by the Ethernet Device Configuration Tool
is stored volatile in the gateway, and is thus lost after power­off at
the device.
Note also that in case of a missing or defective firmware (which is
indicated by a green POW LED), the tool will still be able to locate
the gateway via netIDENT protocol, but it will not be able to assign
an IP address to the gateway then, not even a temporary IP
address. In this case you have to use a DHCP server to assign an
IP address to the gateway in order to perform a firmware download
(see chapter Firmware recovery via HTTP [} page 100]).
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· STEP 7
For further information, please refer to section Using STEP 7 to Assign
Device Name or IP Address on the Gateway [} page 83].

10.3 Step­by­step instructions for updating firmware
Ø Start your web browser.
Ø In the address bar of your browser, enter URL: http://<IP

address>/fwupdate

Ê The user authentication dialog opens.
Ø Enter user name adminand password admin.

Note:
The current version of the firmware does not provide options to
customize the user authentication of the web server by creating own
groups, users or passwords.

Ê The following web page opens:

Figure 57: Firmware update by HTTP (as depicted in Internet Explorer)

The Firmware Identification section displays the following information:
· Channel number (port number)
· Name of loaded firmware
· Firmware version
· Date of firmware

The Firmware Update section features the following control elements:
Control element Function
Selection field Shows selected file and its location
Browse… Opens the file selection dialog
Transfer Uploads selected firmware file to device
Cancel Cancels firmware update and clears selection field
Table 28: Controls in firmware update page
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Ø Click Browse… button, to open a dialog box for selecting the firmware
file.

Ø Select the firmware file and close the dialog box

Note:
The filename extension of firmware files is .nxf

Ê Path and name of the selected file are displayed in the field next to the
Browse… button.

Ø Click Transfer button to load the new firmware file to the gateway.

Hazard of device damage by disruption of voltage supply during
firmware update!
Do not interrupt the voltage supply while updating the firmware of the
gateway. Power failure during a writing process in the file system can
cause severe malfunctioning of the device.

ð After you have started the upload by clicking the Transfer button, the
validity of the firmware file is being checked by the system. If the file
fails the validity check, the file will not be stored in the gateway and an
error message will be displayed on the web page. If the file passes, a
Transfer succeeded message will be displayed.

Note:
After successful transfer, you need to reset the gateway in order to
start up the new firmware.
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10.4 Resetting gateway
Ø In the address bar of your browser, enter URL: 

http://<IP address>/reset

Ø If the user authentication dialog opens, enter user name admin and
password admin.

Ê The following web page opens:

Figure 58: Reset by HTTP (as depicted in Internet Explorer)

Important:
Please note the following consequences of a reset:
The firmware is being restarted and connections will be interrupted
or timed out.
I/O bus communication is being stopped.
The IP connection gets lost, if the gateway is not connected to a
PROFINET IO controller and the IP address has not been
permanently stored in the gateway.

Ø Activate the checkbox in front of Please confirm… to acknowledge that
you want to reset the device.

Ø Then click Submit button to start the reset.

You can use the Cancel button to uncheck the checkbox in front of Please
confirm...
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11 Firmware recovery via HTTP

11.1 Overview
If the POW system status LED of the gateway shows steady green light,
the “regular” firmware of the gateway is defective or missing (for the
position of the POW LED see section Positions of the LEDs [} page 28]).

In this case only the so­called “backup firmware” is running and the device
is not able to perform its normal gateway functions. This state can be
resolved by downloading a fresh (i. e. uncorrupted) firmware file into the
gateway via HTTP protocol. The backup firmware (which is part of the boot
strap loader running in the gateway) carries a “web server” functionality for
downloading a firmware file comfortably via its Ethernet interface.

For this, you just have to connect the gateway via its Ethernet interface to
an active DHCP server and a configuration PC. The purpose of the DHCP
server is to assign an IP address to the gateway. This assigned IP address
can then be used by the configuration PC to connect to the download
function of the backup firmware running in the gateway, in order to
download the new firmware file via ordinary web browser. 
If you do not know the exact IP address assigned to the gateway by the
DHCP server, you can use the Hilscher Ethernet Device Configuration
Tool on your configuration PC (included on the product DVD) in order to
“read out” the newly assigned IP address from the gateway. (The tool uses
the netIDENT protocol to search for all Hilscher devices within the
connected IP network, and then lists all found devices and their IP
addresses.)

Note:
This chapter describes only how to download the recovery firmware.
Instructions on how to configure and operate a DHCP server are not
subject of this manual. For information on using a DHCP server,
please consult your local network administrator.
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11.2 Prerequisites
· The gateway is supplied with voltage and the backup firmware inside
the device is running (this is indicated by steady green light at the POW
LED)

· The gateway is disconnected from the PROFINET network
· The gateway is connected to an active DHCP server via local Ethernet
network

· The gateway is connected via local Ethernet network to a configuration
PC with installed standard web browser

· You have access to the firmware file which you want to download to the
gateway (the firmware is stored on the SmartWire­DT Gateway
Solutions product DVD in the Firmware\EU5C­SWD­PROFINET
\Vx.x.x.x folder).

· You know the IP address, which the DHCP server has assigned to the
gateway. If not, install the Hilscher Ethernet Device Configuration
Tool on your configuration PC. This tool allows you to check the current
IP address of the gateway (if the configuration PC and the gateway are
connected to the same local Ethernet network). An installer for this
program can be found on the product DVD in the Software
\EnDeviceCfg folder (the program can also be installed by using the
menu of the product DVD.)

11.3 Step­by­step instructions
1. Use DHCP server to assign IP address to gateway.
Ø Disconnect the gateway from the voltage supply.
Ø Plug a cable connected to the local Ethernet network (in which a DHCP
server is active) into one of the Ethernet RJ45 sockets (labeled LAN1­
IN or LAN2­OUT) on the front side of the gateway.

Ø Reconnect the gateway to the voltage supply.

Note:
The L/A LINK/Activity LEDs of the Ethernet RJ45 sockets remain
dark when an Ethernet cable is plugged­in while the backup
firmware is running – even if a successful IP communication with an
local Ethernet network has been established.

Ê The backup firmware running in the device now sends a so­called
DHCPDISCOVER message broadcast into the Ethernet network,
requesting an IP address from a DHCP server. If a DHCP service is
available in the network, the gateway should be receiving a valid IP
address from the server within a few seconds.
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2. Check IP address.
Ø In the Windows Start menu of your configuration PC, select All
Programs > Hilscher GmbH > Ethernet Device Configuration, to
start the Ethernet Device Configuration Tool.

Ê The Ethernet Device Configuration tool opens:

Figure 59: Ethernet Device Configuration Tool

Ø Click Search Devices button, to start searching for the gateway within
the local Ethernet network.

Ê The tool starts scanning for devices and lists all found Hilscher devices
and their IP addresses:

Figure 60: Found gateway in Ethernet Device Configuration Tool

Ø Note or write down the IP address.

Note:
If the default IP address 0.0.0.0 is displayed, the gateway has not
yet received an IP address from a DHCP server. Make sure that the
gateway is connected to a subnet with an active DHCP server.
Then restart the gateway by briefly disconnecting the voltage supply
while the Ethernet cable remains plugged­in. Wait a few seconds
after reconnecting the voltage supply, then click the Search
Devices button in the Ethernet Device Configuration Tool again.
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3. Open web page for firmware download.
Ø Start the web browser on your configuration PC.
Ø In the address bar of your browser, enter the IP address of the gateway:

http://<IP address>

Ê The Firmware Update page opens:

Figure 61: Firmware recovery via HTTP (as depicted in Internet Explorer)

4. Select firmware file for download.
Ø Click Browse… button, to open a dialog window for selecting the
firmware file you want to download.

Ø Navigate to the directory in which the firmware file is stored, select the
file, then click Open.

Note:
The name of the firmware file for the EU5C­SWD­PROFINET
gateway is E030D0U0.nxf

Ê Path and name of the selected file are displayed in the field next to the
Browse… button.

5. Download firmware file to gateway.
Ø Click Transfer button to download the new firmware file to the gateway.
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Ê After you have started the download by clicking the Transfer button, the
validity of the firmware file is being checked by the system. If the file
fails the validity check, an error message will be displayed. If the file
passes, the gateway requests you to perform a reset in order to start
the new firmware:

Figure 62: Reset after firmware download via HTTP (as depicted in Internet Explorer)

6. Perform reset.
Ø Activate the checkbox in front of Please confirm… to acknowledge that
you want to reset the gateway.

Note:
You can use the Cancel button to uncheck the checkbox in front of
Please confirm...

Ø Click Submit button to start the reset.
Ê After successful reset, the following message is displayed:

Figure 63: Successful device reset message (as depicted in Internet Explorer)

ð The POW system status LED at the gateway shows steady yellow light.
The new firmware has been loaded and the gateway is ready for
operation.
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12 Technical data

12.1 Technical data EU5C­SWD­PROFINET gateway
Category Parameter Value
General Part number 9233.920

Dimensions 
(W x H x D)

35 x 90 x 127 mm

Weight 160 g
Mounting Top hat rail 35 mm (IEC/EN 60715)
Mounting position Vertical
Standards IEC/EN 61131­2
Communication controller netX 50 processor
Diagnostic interface Mini­USB
Integrated memory 8 MB SDRAM

4 MB serial Flash EPROM
Ambient mechanical
conditions

Protection type 
(IEC/EN 60529, EN50178, VBG 4)

IP20

Vibrations 
(IEC/EN 61131­2:2008)

Constant amplitude 3.5 mm: 5 – 9 Hz
Constant acceleration 1 g: 9 – 150 Hz

Mechanical shock resistance 
(IEC/EN 60068­2­27)

Semi­sinusoidal 15 g/11 ms: 9 Shocks

Drop to 
(IEC/EN 60068­2­31)

Drop height: 50 mm

Free fall, packaged 
(IEC/EN 60068­2­32)

Drop height: 1 m

Ambient climatic conditions Operating ambient temperature 
(IEC 60068­2)

­25…+55 °C

Condensation Prevent by suitable measures
Storage ­40…+70 °C
Relative humidity, non­condensing
(IEC/EN 60068­2­30)

5…95 %

Electromagnetic
compatibility (EMC)

Pollution degree 2
Electrostatic discharge 
(IEC/EN 61131­2:2008)

Air discharge (Level 3): 8 kV
Contact discharge (Level 2): 4 kV

Electromagnetic fields 
(IEC/EN 61131­2:2008)

80 – 1000 MHz: 10 V/m
1.4 – 2 GHz: 3 V/m
2 – 2.7 GHz: 1 V/m

Radio interference suppression
(SmartWire­DT)

EN 55011 Class A

Burst 
(IEC/EN 61131­2:2008, Level 3)

Supply cables: 2 kV
PROFINET bus cable: 1 kV
SmartWire­DT cables: 1 kV

Surge 
(IEC/EN 61131­2:2008, Level 1)

Supply cables: 0,5 kV
PROFINET bus cable: 1 kV

Radiated RFI
(IEC/EN 61131­2:2008, Level 3)

0.15 – 80 MHz, 10 V, 80% AM / 1 KHz
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Category Parameter Value
Supply voltage UAUX Rated operational voltage 24 V DC

­15 % +20 %
Input voltage residual ripple ≤ 5 %
Protection against polarity reversal Yes
max. current Imax 3 A

Note: If contactors with a total power consumption >
3 A are connected, a power feeder module EU5C­
SWD­PF1/2 has to be used.

Short­circuit strength No, external fuse FAZ Z3
Heat dissipation Typ. 1 W
Potential isolation No
Rated operating voltage of 24­V­DC
slaves

Typical UAUX ­0.2 V

Supply voltage UPOW Supply voltage 24 V DC
­15 % +20 %

Input voltage residual ripple ≤ 5 %
Protection against polarity reversal Yes
Rated operational current I 111 mA (with two participants)
Heat dissipation at 24 V DC 2.66 W (with two participants)
Potential isolation between UPOW and
15­V­SmartWire­DT supply voltage

No

Bridging voltage dips 10 ms
Repeat rate 1 s
Status display Yes

SmartWire­DT supply
voltage

Rated operational voltage Ue 15 V ± 3 %
max. current Imax 0.7 A

Note: If contactors with a total power consumption >
0.7 A are connected, a power feeder module EU5C­
SWD­PF2 has to be used.

Short­circuit strength Yes
Connection supply
voltages

Connection type Push­in terminals
solid 0.2 – 1.5 mm2 (AWG 24 – 16)
Flexible with ferrule 0.25 – 1.5 mm2

SmartWire­DT network Participant type SmartWire­DT master
SmartWire­DT Master ASIC SWD­80P­RS485
Number of SmartWire­DT slaves 99
Baud rate 125 / 250 kBd
Address setting Automatic
Status display SmartWire­DT master: SWD LED, duo color red/

green
Configuration: Config LED, duo color red/green

Connections Plug, 8­pole
Plug connectors Blade terminal SWD4­8MF2
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Category Parameter Value
PROFINET IO network Function PROFINET IO Device (Slave)

Baud rate 100 MBit/s
Interface type 100 BASE­TX
Half duplex/full duplex Supported
Auto­Negotiation Supported
Auto­Crossover Supported
Address setting Automatically via PROFINET IO
Status display PROFINET IO device: APL, SF, BF LEDs, duo

color red/green
Connector socket 2 x RJ45
Connector plug RJ45
Potential isolation Yes
Table 29: Technical data EU5C­SWD­PROFINET gateway

SmartWire­DT Gateway | EU5C­SWD­PROFINET
DOC120304UM07EN | Revision 7 | English | 2015­06 | Released | Public

© Hilscher 2012 – 2015



Technical data 108/112

12.2 Technical data PROFINET IO Device (Slave)
Parameter Description
Maximum number of cyclic input data 800 bytes
Maximum number of cyclic output data 642 bytes
Maximum number of cyclic input/output
data in sum

1000 bytes

Supported protocols RTC – Real Time Cyclic Protocol, Class 1 and 2 (unsynchronized)
RTA – Real Time Acyclic Protocol
DCP – Discovery and configuration Protocol
CL­RPC – Connectionless Remote Procedure Call
LLDP – Link Layer Discovery Protocol
SNMP – Simple Network Management Protocol

Used Protocols (subset) UDP, IP, ARP, ICMP (Ping)
Topology recognition LLDP, SNMP V1, MIB2, physical device
VLAN and priority tagging Yes
Context Management by CL­RPC Supported
Minimum cycle time 1 ms for RTC1 and RTC2
Baud rate 100 MBit/s
Data transport layer Ethernet II, IEEE 802.3
Ethernet Switching Cut­through
Limitations RT over UDP not supported

Multicast communication not supported
DHCP is not supported
RT Class 2 synchronized (IRT “flex”) is not supported
RT Class 3 synchronized not supported
FastStartUp is not supported
Media Redundancy (except MRP client) is not supported
Access to the submodule granular status bytes (IOCS) is not supported
The amount of configured IO­data influences the minimum cycle time that
can be reached
Supervisor­AR is not supported, Supervisor­DA­AR is supported
Only 1 Input­CR and 1 Output­CR are supported
Multiple WriteRequests are not supported

Table 30: Technical data PROFINET IO RT Device protocol
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